Child Welfare Pre-Service Training

Ongoing Assessment/Permanency
FSFN Computer Instruction

Participant Guide

July 2013
PLEASE NOTE

Access to FSFN person or case information must only occur when there is a legitimate business purpose. FSFN must not be used to access any of the following:

- Persons or cases in the news, or
- Persons or cases about which you are “curious”, or
- Persons or information about your own personal case, or
- Persons or cases of family members, or
- Persons or cases of friends, neighbors or acquaintances, or
- Any other persons or cases for which there is no legitimate business reason for you to access the information.

Please use common sense when accessing FSFN; if you have any questions about the appropriate use of FSFN, please contact your supervisor and/or your agency's IT Support personnel.

The materials for the Child Welfare Pre-Service Training curriculum were produced by Florida International University for the State of Florida, Department of Children and Families, Office of Family Safety.

© 2006 State of Florida, Department of Children and Families

The materials for the Child Welfare Pre-Service Training curriculum were formatted and edited by the Child Welfare Training Consortium at the University of South Florida.

© 2013 Child Welfare Training Consortium at the University of South Florida
# Table of Contents

**Ongoing Assessment and Permanency Scenario: Part 4** .......................................................... 1

**Module 1: Ongoing Case Notes** ........................................................................................................ 1
  - Face-to-Face Contacts .................................................................................................................. 1
  - Viewing and Printing Notes ........................................................................................................ 2
  - Updating Identification Records/AFCARS ................................................................................. 3
  - Creating TANF for Ongoing Services ....................................................................................... 4

**Module 2: Missing Child Record** ................................................................................................. 1
  - Documenting a Missing Child Record ........................................................................................ 1
  - Documenting a Rapid Recovery .................................................................................................. 3
  - Documenting a Placement Change When Child is Missing ....................................................... 4

**Module 3: Relative Placement** .................................................................................................... 1
  - Adding a Case Participant ......................................................................................................... 1
  - Out-of-Home Placement Change ............................................................................................... 2
  - Create Person Providers ........................................................................................................... 3
  - Update Person Providers .......................................................................................................... 4
  - Creating New Placement .......................................................................................................... 5
  - Approving the Out-of-Home Placement .................................................................................... 6
  - Unified Home Study ................................................................................................................. 7
  - Updating Out-of-Home Plan ..................................................................................................... 8
  - Visitation Plan .......................................................................................................................... 10

**Module 4: Judicial Review Social Study/Case Plan Update** .................................................... 1
  - Ongoing/Updated Family Assessment ....................................................................................... 1
  - Updating the Child Assessment .................................................................................................. 4
  - Updating the Adult Assessment .................................................................................................. 7
  - Approving the Updated Family Assessment ............................................................................. 10
  - Creating the FSFN Judicial Review/Task Evaluation ................................................................. 11
  - Judicial Review/Goal Evaluation .............................................................................................. 15
  - Approving the Judicial Review/Task and Goal Evaluation ....................................................... 20
  - FN1, Angela JJRS/CPU ............................................................................................................. 22

**Module 5: Medical/Mental Health Documentation** ................................................................. 1
  - Create a Medical/Mental Health Profile & History .................................................................... 1
  - Medical History Tab ................................................................................................................... 2
<table>
<thead>
<tr>
<th>Module 6: Parental Reunification</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parental Reunification Readiness Assessment and Home Study</td>
<td>1</td>
</tr>
<tr>
<td>FN1, Angela Parental Reunification Readiness Assessment and Home Study</td>
<td>2</td>
</tr>
<tr>
<td>Module 7: Case Closure</td>
<td>1</td>
</tr>
<tr>
<td>Closing a Case</td>
<td>1</td>
</tr>
<tr>
<td>Submitting Case for Closure</td>
<td>2</td>
</tr>
<tr>
<td>Module 8: Independent Living</td>
<td>1</td>
</tr>
<tr>
<td>Independent Living Program Referral</td>
<td>1</td>
</tr>
<tr>
<td>Independent Living Record</td>
<td>2</td>
</tr>
<tr>
<td>Module 9: Interstate Compact for the Placement of Children</td>
<td>1</td>
</tr>
<tr>
<td>Interstate Compact</td>
<td>1</td>
</tr>
<tr>
<td>Self-Led Instruction</td>
<td>1</td>
</tr>
<tr>
<td>Ongoing Assessment and Permanency Scenario: Two</td>
<td>1</td>
</tr>
<tr>
<td>Power Point Slides</td>
<td>1</td>
</tr>
</tbody>
</table>
Ongoing Assessment and Permanency Scenario: Part 4

FN1, Angela

On 11/05/2008, 10:00 am: Home visit with Fred at his current foster home. Nanny Seed, the foster parent, has taken him to all scheduled medical appointments and helps with the transportation of Fred to and from supervised visitations with his mother. Ms. Seed states that Fred is doing very well at daycare and that “the daycare employees adore him.” New photo of Fred taken in order to update the child’s identification records.

On 11/21/2008: Received home visit report from Hillsborough County. Christina had initially adjusted well to the placement. Family was receiving all necessary services and was in compliance. Ms. Rachel Burke advised that Christina was reevaluated at a recent medical checkup and taken off the Concerta medication. James FN3 and Christina appeared to have connected and bonded. Initially both James and Wendy “enjoyed having Christina in the home” and wanted her to live with them permanently. However, some problems have recently surfaced. Christina began expressing a desire to live with her aunt so that she can have “the sister that she always wanted.” Her interactions with Wendy and Joshua have begun to deteriorate and Joshua has started acting out. This concerns James and Wendy and they have been discussing their options with Ms. Burke. Case Manager will continue to monitor situation and provide monthly reports.

On 12/04/2008 5:00 pm: Telephone call from Christina’s father, James FN3. He advised that Christina has been spending a lot of time at his sister’s home, Kathleen FN5. Kathleen has a child close in age to Christina and they have become like sisters. He advised that the child has on occasion gotten off the bus at the FN5’s home without their approval. Mr. FN3 advised that he does not mind her spending time with his sister and her child, but that Christina is no longer listening to his rules and thinks that she can dictate where she lives. He has spoken with the Hillsborough County Case Manager and wanted to discuss what his options were in regard to the child living with the aunt.

On 12/07/2008 4:00 pm: Received telephone call from James FN3 who was very upset. He stated that Christina did not return home from school today and that she could not be located. He had called his sister Kathleen, but she had not seen or heard from Christina. He stated that he had called the police and had also contacted Angela to see if she had heard from Christina. Angela advised that she had not heard from Christina, but will contact Mr. FN3 immediately if she hears anything. Angela also advised that she would make some calls to see if anyone had heard from Christina. Mr. FN3 had also called several of Christina’s friends, all of whom indicated that they had not seen her in school. Mr. FN3 was advised to continue contacting possible friends and to keep you informed. You contact CLS advising them of the missing child and need to notify the court.

On 12/08/2008 5:00 pm: Telephone call from Mr. FN3. He advised that the child showed up at his sister’s home. She told Kathleen that she wanted to live with her and that she had been at a friend’s house. He advised you that he is upset with her behavior and that maybe it is better if she does live with Kathleen. He had notified Angela of the child’s return and the local police. You contact CLS advising them of the child’s return.
On 12/10/2008: Monthly home visit report from Hillsborough County regarding Christina’s placement with her father. Christina’s behavior and school performance has recently deteriorated. She is arguing with her “stepmother” and continues to “demand” to live with her aunt, Kathleen FN5, and cousin who reside in the same neighborhood. Kathleen has a 6 year old daughter, Mary, who is in the first grade and goes to school with Christina. Kathleen is a widow who lost her husband in a car accident 2 years ago. Mary and Christina have become very close. They have developed the same afterschool hobbies, and both enjoy soccer and piano lessons. Kathleen has expressed a strong desire to have Christina come and be a part of her family. James, Kathleen and Christina have discussed this as a placement option for Christina. James contacted the Hillsborough County Case Manager, Rachel Burke, with this information. Ms. Burke stated that a home study will be conducted on Kathleen FN5 and, if it is positive, Christina could be placed with her Aunt, Kathleen FN5, as a relative placement. Kathleen provided Ms. Burke with all of her demographic information: Kathleen FN5; DOB 12/11/1983; Address 125 North Street, Tampa Florida 33511; Phone number 813-948-4567; SS# 124-59-3256. Kathleen is a nurse and has been employed at United Primary Care Doctors office for 3 years. The Case Manager agreed that the best option would be to recommend to the court that Christina be placed with Kathleen FN5 followed by six months of supervision.

On 12/10/2008: Fred continues to do well with his foster parent, Nanny Seed, and all medical appointments confirm that he is developing normally. Visitation with his mother, Angela, has been successful and he has experienced no behavioral problems. Angela has complied with all service referrals. She completed 8 weeks of Outpatient Substance abuse treatment and provided her certificate of completion to the CM on 12/08/2008. She is currently enrolled in a 6 week Positive Parenting Program that she expects to complete on 1/16/2008. She consistently communicates regarding her case plan tasks. She started a new job as a receptionist on 12/05/2009. She works 9:00 a.m. – 5:00 p.m., Monday through Friday. She communicates regularly with Christina in Tampa via phone calls and letters and is happy that Christina is doing so well with the father and his family. Angela stated that she understands Christina’s desire to stay with her aunt and fully supports the new goal recommendation. However, Angela expressed a strong desire to have Fred return home to her care. Monthly visits have been completed with John FN2 in the Baker County Jail. Mr. FN2 is still awaiting trial on the distribution of cocaine charges. The Baker County jail does not provide the services necessary for Mr. FN2 to complete his case plan tasks. The recommendation for Fred is reunification with his mother, Angela, with weekly home visits and post-placement supervision for 6 months. John FN2 will have no visitation with Fred until he completes a drug assessment and treatment.
**On 12/17/2008:** Received a phone call from Rachel Burke, Hillsborough County Case worker. She had completed a home study on Kathleen FN5 and it is positive. Kathleen has no criminal history and has the capacity and willingness to care for Christina. The father, James and Kathleen have been working together to transition the child over to the aunt’s home and the father will continue to provide for the child and will continue to see the child regularly. Both feel that this is the best “fit” for Christina as she had started to develop behavioral problems within the last month. In addition, she has not been getting along with her stepbrother, Joshua and the placement was having a negative effect on both of the children.

You contact CLS and advise them you like to schedule a change of custody hearing as soon as possible to change Christina’s placement.

**On 12/22/2008:** A Change of Custody hearing is held. The mother, her attorney, and you are present. The Judge approves the Unified Home Study and places Christina with Ms. FN5 with a minimum of six months of supervision.

You contact Rachel Burke and advise her that Christina can be moved to Ms. FN5’s home. Ms. Burke will contact the father and Ms. FN5 to schedule on 01/10/2009. Received monthly home visit report from Hillsborough county. Christina is doing well in her placement with her aunt. Her behavior has vastly improved. Since her move, Christina has become more affectionate towards her father’s paramour and her stepbrother. Christina’s father usually comes by two or three times a week to check on Christina and to make sure she has everything she needs. Christina has also started going to her father’s house for dinner on Sunday nights and sometimes she will bring her cousin, Mary, with her. Christina is doing much better in school; her most recent progress report shows a significant improvement in her grades as well as her conduct. Christina also continues to have regular phone contact with her mother. Christina said her mother was happy that Christina had a little sister to play with now.

**On 01/12/2009:** Monthly contact with Fred finds the child continuing to progress. Child is developing normally and presents with no type of health or emotional issues. His visits with his mother continue to progress with successful overnight and weekend visits. The family remains on task for reunification.

**On 02/12/2009 8:30 am:** JRSS/CPU completed prior to the scheduled Judicial Review hearing for Christina and Fred, and submitted to CLS for review and filing on March 3, 2009. An updated Family Assessment is also completed based on input solicited from the children, family and team.

**On 02/25/2009 4:30 pm:** Telephone call from Nanny Seed advising that Fred became ill and was taken to the doctor today. He was diagnosed with Croup and prescribed the antibiotic Amox– Clav for 10 days.

**On 03/03/2009 at 8:30 am:** Judicial Review Hearing held. Angela FN1, Shirley FN1 and James FN3, Christina’s father, and Kathleen FN5, paternal aunt are present. The judge approves Fred’s reunification with his mother under 6 months of post-placement supervision. The judge continues Christina’s placement in her paternal aunt’s home and her goal will be changed to permanent guardianship after a minimum of six months of supervision is completed.
Module 1: Ongoing Case Notes

Face-to-Face Contacts

Click Casework in the banner bar on the Desktop → Click on the dropdown box Narrative → Choose Case

From the Case box on the right, click the FN1, Angela (AD) case

In the Case Participants box, Select FN1, Fred (AD)

Click Create → Complete mandatory blue shaded sections

In Begin/Date and Time Enter: 01/12/2009 10:00 am

In End/Date and Time Enter: 01/12/2009 11:00 am

Select Note Type Home Visit - Child’s Current Residence

Select worker activity code based on directive from your agency.

Enter Narrative

Monthly home visit was completed with Fred. The child is developing normally and presents no type of health or emotional issues. Fred visits with his mother regularly, and overnight and weekend visits have begun and are very successful. The family remains on task for reunification. The foster parent supports the reunification goals and is willing to help Angela with any transitional assistance that may be necessary if reunification is achieved. The Judicial Review hearing is scheduled for March 3, 2009.

Click on Add Face-to-Face Contacts hyperlink Scroll down to Contact Information

Choose completed in the Face to Face Dropdown box next to FN1, Fred (AD) Under Other Contacts Click Insert

Enter: Nanny Seed Enter: Affiliation and required title fields Enter: Contact date and time

Click Save once when all fields are completed → Click Close
Viewing and Printing Notes:

Click the **Actions** hyperlink by **FN1, Angela (AD)** case

- Reveals pop-up box
  - Click **Case Note Criteria Search**
  - Change the dates if needed

- Adjust dates as necessary or leave as 60 day default

Click **Continue**

Select category **Child Investigations and Case in order to get ALL documented notes for selected participants**

- Automatically selects all types

Select **Add**

In **Case Participant Box**

- Select participants whose notes are to be viewed

Click **Search**

- Displays all case notes meeting that criterion

**To View or Print a Single Note:**
Click **View** hyperlink and **Print** hyperlink

**To View or Print all notes:**
Scroll to the bottom of the page.
Click the options box
Select **View all Notes**
Click **Go** to display all notes in a Word document to view and/or print
Click **Close and Return to FSFN** or **Click X** in the right corner of the document.
Updating Identification Records/AFCARS

From Desktop open Maintain Case Page

On Participants tab

Click the Additional tab

In Person Information, in the Identification Records section

Ensure accurate date is entered for Birth Verification and Fingerprint Date is the date information was obtained

To search for Florida Birth Certificate

Select blue Search hyperlink
Leave the radio button on Child’s Info (AD)
Enter Child’s Last Name in the last name text field

Select Continue

Select Search
Locate Child’s Name (AD) and select

Select Upload New Photo
Enter: 01/21/2009 in Date Document
Scanned date field
Select Type: Person Photo
Select: Browse and double click on photos to be uploaded

In the Person Photo section

Click Save

Click Close

Click Disability/AFCARS tab

Review the School Information and Disability Information for Fred
Creating TANF for Ongoing Services

From the Create Case Work menu

In the Household Information box

Click the checkbox next to each household member in the Include column

Click the checkbox next to each household member in the U.S. Citizen or Qualified Non-Citizen column

In the Question box

Select Yes to Question 1: Was (were) the child(ren) living with a Parent or other Specific Relative at the time of investigation or at the time of the request for services?

Select Yes to Question 2: Is (are) the child(ren) currently residing in the State of Florida?

Select No to Question 3: Is the family currently receiving case assistance under the Temporary Case Assistance Program or the Relative Caregiver Program.

If Yes, Eligible. If No, go to Question 4.

Question 4: Family Income: Information Obtained From:

Select: Self Declared

In the Eligibility Applies To Column the checkbox is prefilled with the child's name for whom the form is being created.

Select: Mother in the Relationship to Child dropdown

The mother's name auto populates from the additional tab of the youngest child's person management screen.
If Self Declared is selected: Explain text field is enabled.
If Documented is selected: Explain text field is enabled and required.
If Collateral is selected: Explain text field is enabled and required
If Unable to Obtain is selected: Explain text field is enabled.

The Family Size pre-fills from number of check boxes selected in the Include column of the Household Information group box

In Estimated Family Income

Click monthly

Enter: 0 (the mother is currently unemployed and the child's father had no legal source of income)

Select: Request for TANF Eligibility Determination 5244.

Print the TANF Funds/Eligibility Determination Form 5244 template for case file records when appropriate

Click Close and Return to FSFN OR Click X in the right corner of document

Click Save

Click Close

From the Options dropdown box

Select: Approval

Click Go

Click Approval

Click Continue

Click Save

Click Close
Module 2: Missing Child Record

Documenting a Missing Child Record

From the Desktop
Select: Create on the Menu Bar

From the Dropdown Menu
Select: Case Work

From the MCR dropdown
Select: Missing Child Record
Select: FN1, Angela (AD) from Case group box
Select: FN1, Christina (AD) from Case Participants

Click Create
Click Yes to pop-up message to verify child’s person information

On Child Information tab
Enter Date Reported to DCF/CBC: Auto populates
Select District: District 4
Select Eye Color: Brown
Select Hair Color: Black
Enter Height: 401
Enter Weight: 99
Select Case Type: Runaway
Select Alert Type: Runaway
Enter Missing from Date: 12/07/2008

Select Missing from Location: Home-Single Family
Enter Street Information: 565 South St
Select FL City: Tampa
Select County: Hillsborough
Select State: FL
Enter Zip: 33511

In the Missing From Address group box
Click Validate to validate address entered

Click Caller/Law Enforcement tab: In Law Enforcement information group box
Select: User Entered address
Select: Continue
Select: No to all questions

Enter Case (OCA Number): CCR 09-34765
Enter Date LE notified: 12/07/2008
Enter LE Agency Name: Hillsborough County Sheriff Office
Enter Address: 7616 E. Ashley Street
Enter City: Tampa
Select State: FL
Enter Zip: 33612
Enter Phone Number: 813-630-1000
Christina is a 10 year old who did not return home from school and her whereabouts are unknown. Her father, James FN3, reported her missing to the local Hillsborough County Sheriff’s office and is very worried about his daughter. Christina has never run away before and is too young to be anywhere by herself. She has been living with her father in Tampa since September 15, 2008. James has gone everywhere he can think of in attempt to find his daughter and has been unable to locate her. James’ sister, Kathleen FN5, lives in the same neighborhood and she does not know Christina’s location either.
Documenting a Rapid Recovery

From the Desktop drill down in the FN1, Angela (AD) case folder

Access MCR hyperlink for FN1, Christina (AD)

From the Options dropdown box:
Select: Rapid Recovery

Enter Recovery Date: 12/08/2008
Enter Recovery Type: Located
Enter Recover from Address: 125 North St
Enter City: Tampa
Enter County: Hillsborough
Enter State: FL
Enter Zip: 33511

Click Go

In the Recover Narrative text field, enter:

Christina was located on December 8, 2008 when she appeared at her aunt Kathleen’s house. Christina’s father, James FN3, contacted the Case Manager and the local sheriff’s office notifying them of Christina’s return. Christina stated that she went to a friend’s house after school and spent the night.

Click Save

Select Yes to pop-up message to lock the information in FSFN.
Documenting a Placement Change When Child is Missing

From the Desktop
- Drill down in the FN1, Angela (AD) case to the Placement/Services icon

Click FN1, Christina’s (AD) Living Arrangement hyperlink
- Enter End Date and Time: 12/07/2008 4:00 pm

Click Save

Click Close

From the Desktop, click Casework in the banner bar
- Select Placement: Living Arrangement
- Select Case: FN1, Angela (AD)
- Select Participant: FN1, Christina (AD)

Click Create
- Enter Begin Date and Time: 12/07/2008 4:00 pm
- Select Living Arrangement Type: Runaway
- Select Primary Caregiver: FN3, James (AD)

Click Save

Click Close

You will now update Christina’s living arrangement information when she is recovered on 12/08/2008

Click Christina’s Living Arrangement hyperlink (unless already open on desktop).
- Enter End Date and Time: 12/08/2008 08:00 am.

Now you must create a new living arrangement for Christina as she is back with her father.
Documenting a Placement Change When Child is Missing

From the Desktop

Click Casework in the banner bar.

From the Placement dropdown

Select: Living Arrangement
Select Case: FN1, Angela (AD)
Select Participant: FN1, Christina (AD)

Enter Begin Date and Time: 12/08/2008 08:01am.
Select Living Arrangement Type: Living with one parent
Select Primary Caregiver: FN3, James (AD)

Click Create

Click Save

Click Close

Refresh desktop to view all updates.
**Module 3: Relative Placement**

**Adding a Case Participant**

1. Click FN1, Angela (AD) Case hyperlink.
2. From the Maintain Case screen on the Participant tab, in the Participants group box, click Insert to display the Search Person page.
3. Type FN5 (AD) in the last name field and K* in the first name field.
4. Pop-up box appears stating “no matching data found”
5. Close pop-up box.
6. Change the wildcard name to Kathleen with the Alpha Designator.
7. The Person Management page displays with the Basic tab open - enter all applicable information; Social Security Number is mandatory.
8. Click Search
9. Click Create
10. Click the Address tab
11. Click Insert
12. Answer Yes to pop-up message
13. Enter: Address Information
14. Click Save
15. Select: User Enter Address
16. Click Continue
17. Click Close
18. Click Close again
19. On the Person Search Results page; you will see Aunt’s name
20. Click Continue
21. Select: Primary Caregiver in the Service Role dropdown box
22. Update other family members’ roles
23. Add Aunt’s relationship: Approved Relative Caregiver to Christina
24. Click Relationship tab
25. Click Insert
26. Click Save and Close again to return to Desktop
Out-of-Home Placement Change

From the Desktop; Expand the FN1, Angela (AD) Case File

Expand the Placement/Services expando

- Select the Living Arrangement hyperlink for Christina that is currently open (will have no end date)
- Enter End Date and Time: 12/22/2008 11:00am

Click Save and Close to return to your desktop
Create Person Providers

From the Menu Bar, Click Create. Click Provider Inquiry, Click Person

Click Search

Click Add Participants

Click Continue

Under Member Tab from Role drop down box

Click the Basic tab

Select the Inquiry Type

In the Worker group box > Accept

Select Reason: Meets Requirement

Click Save and Close

Enter: Relative Caregiver’s Last & First Names
FN5, Kathleen (AD)

Click Select hyperlink next to aunt’s name

Brings up the Person Provider Inquiry box

Give aunt a role of Caregiver 1

Select: Single Female for Marital Status
Select: Primary Language

Relative/Non-Relative

Supervisor approves

From the Desktop, expand Provider expando to find your Relative Provider
Update Person Providers

From the Desktop, Click Providers expando

In the Basic group box at the top of the page Select:

- Click the Provider Name hyperlink that you just created
- The Basic Provider information window opens

In the Member Tab:

- Type: Relative/Non-Relative
- Status: Active
- Lcns. Type: Approved

In the Characteristics Tab:

- Review, but no changes are necessary

In the Services Tab:

- Total Bed Capacity: 13
- Clients by Gender box will automatically populate
- Keep Preferred Age 0-17
- Services Specific boxSelect your fiscal agency
- Click Edit Other Services hyperlink: Pop-up box appears saying “this action will save your provider information. Do you want to continue? Click Yes
- Edit Other Services box opens.
- Click Insert. Select from dropdown boxes:
  - Category: Relative
  - Type: Relative Placement
  - Status: Active
  - Total Capacity: 13 (Number must match Services tab)
  - Click Save and Close

In the Training Tab:

- No changes are necessary

In the Merge History Tab:

- No changes are necessary

Click Save and Close
Creating New Placement

Click **Case Work** on banner

Select **Out-of-Home Placement** from the **Placement** dropdown

Click **FN1, Angela (AD)**
Case Name

Select child: **FN1, Christina (AD)**

Click **Create**

Enter **Removal Date**: 12/22/2008

Press the tab key to display **Removal from Home Reasons**

Select **Child’s Behavior Problems** for Removal from Home Reasons
Must select at least one of the reasons in red (AFCARS)

Click **Continue**. Displays **Removal Time** box

Enter **Time of Removal**: 11:01am
**Time must be after Living Arrangement end time**

From the **Manner of Removal** drop-down

Select: **Court Ordered**

From **Primary Caregiver** (removed from)

Select: **FN3, James (AD)**
Select Caregiver Structure: **Single Male**
Select Placement Begin Date and Time: 12/22/2008 11:10am (**Must be after placement end date of previous placement**
Select: your Fiscal Agency
Select Service Category: **Relative**
Select Service Type: **Relative Placement**
Select Placement Setting: **Foster Family Home-Relative**

Click on **Provider tab**.
Click **Search**

Enter Name: **FN5, Kathleen (AD)**
Click **Search**

Select Aunt’s provider record
Click **Continue**

Select **Paternal Niece for Relationship of Child to Caregiver**

Click **Save and Close**
Approving the Out-of-Home Placement

From the Desktop, Expand the FN1, Angela (AD) case: Expand the Placement/Services icon

Click Out-of-Home Placement hyperlink pending for FN1, Christina (AD)

Click the Options dropdown box

Select Approval

Select Approve

Select Continue

Click Yes to “Would you like the address of the provider to update the child’s current primary address?”

Click Save

Click Close

Refresh the Placement/Services icon

FN1, Christina’s (AD) relative placement with the aunt is approved
Unified Home Study

From the Provider expando, Click on blue hyperlink for FN5, Kathleen (AD)

Opens Person Provider page

From Options on the home tab

Select: Unified Home Study

Click Go

The New Unified Home Study box opens.

Click Create

In the Case Information group box, Click Search next to the Case ID

Case Search Screen displays

Maximize the FSFN Desktop and write down the Case ID for which the placement is being made.

Return to the search screen and enter the Case ID

Click Search

Select the Case and Click Continue.

In the Children Associated group box, select the children on the case that are being placed.

Click the Search Hyperlink next to Person Conducting the Home Study. Search for your Worker ID. Select appropriate Worker
Click Continue.

Select Type: Select Relative/Non-Relative.
Enter Date Home Study Conducted: 12/17/2008.
Select Outcome: Approved – Meets Requirements.
Add additional comments if applicable.

In the Home Study Information group box

Click Save

From the Options dropdown box

Select: Unified Home Study
Click Go.

Close the Template when completed.

Click Save → Click Close
Updating Out-of-Home Plan

From the Desktop, Select Create on the menu bar, then Case Work from the drop-down menu.

From the Planning drop-down, select Out-of-Home Plan.

Click Create.

Out-of-home Plan page.

Review Siblings group box on Placement Considerations tab.

Select No to “Is the child an only child?”

Select Yes to “The placement involves the separation of sibling?”

Review the Placement Setting group box.

Select checkbox “Child can function within a family setting.”

Click the Special Requirements tab.

Click the Placement Safety tab.

In the Placement Provider Knowledge/Skills Options group box Describe narrative field enter:

The paternal aunt, Kathleen, lives in the same neighborhood as Christina’s father, James, in Tampa Florida. Christina loves being with her aunt and cousin Mary and has expressed a strong desire to be placed in their home. No special needs or skills are needed in this placement to provide care for Christina.
In the **Placement Setting** group box, review the **Other Residents**

Contains 2 Yes/No questions

Assure **No** is selected for all questions in the **Other Residents** in the **Placement Setting** box

Click **Save**

Click **Special Requirements** tab

- Select **Out-of-Home Plan** from the **Options**
- Click **Go**

Click **Close and Return to FSFN**

Click **Save**

Click the **Placement Considerations** tab

- Select **Approval** from the **Options** dropdown
- Click **Go**
- Select **Approve**
- Click **Continue**

Click **Save and Close**
Visitation Plan

- From Desktop expand the Angela case
- Expand Planning expando and access Visitation Plan hyperlink

- In the General Information group box, Click Expire
- Click Save
- Click Close

- From Desktop select Create on menu bar
- Select Case Work from the dropdown box

- From the Planning dropdown, select Visitation Plan
- Select FN1, Angela (AD) from list of cases in Case group box

- On the Visitation Plan template, Click the checkbox for Parent
- Enter Effective Date: 12/22/2008
- Enter Children: FN1, Christina and Fred (AD)

- Enter the following information:
  - Maximum Level of Supervision Required for Adult: For Angela select Supervised and Supervised by Dept or Contracted Provider or Relative.
  - Rationale for Level of Supervision: The parent’s drug abuse and inadequate supervision places the children at risk if the visits are not supervised.
  - Location, Time, Frequency: Weekly visitations with Fred and Angela, but due to Christina’s location in Tampa, monthly visitations between Christina and Angela and Fred will be arranged and supervised by Christina’s father, James FN3 and Parental Aunt and Relative Caregiver, Kathleen FNS.
  - Parents Responsibilities: The mother is responsible for attending all scheduled visitations and will provide her own transportation.
  - Agency Responsibilities: The agency will ensure that visitations are occurring and that the visitations are appropriate with positive interaction between the mother and children.
  - Transportation: The parents will provide transportation for themselves and the caregivers will transport the children to and from scheduled visitations.
  - Description of Sibling Visitation: Christina will visit with Fred when she visits with Angela, which due to her location in Tampa, will occur at least once a month.
  - Comments

- On the Menu bar at the top of the template page
- Click Close and Return to FSFN
- Click Save and Close
- Refresh the Desktop to see the Visitation Plan hyperlink
Module 4: Judicial Review Social Study/Case Plan Update
Ongoing/Updated Family Assessment

Ongoing/Updated Family Assessment

From Desktop, Click Case Work icon on the banner bar
Select Family Assessment from Family Assessment dropdown box
Select FN1, Angela (AD) Case Name
Click Create

Click the Prior Intakes/Investigations tab
Enter Narrative

John FN2 is currently incarcerated and serving jail time for his drug charge. The mother, Angela has had no contact with John since the arraignment hearing and since he has been incarcerated.

Click Family tab
In Factors Group box
Click Reason for Agency Involvement.
In first narrative field, enter:

The mother, Angela, was under the influence of drugs while she was pregnant with Fred. She and Fred’s father continued to use drugs and party late into the night leaving the children home alone. John FN2 has been incarcerated since the beginning of the investigation. The mother, Angela, is complying with her case plan tasks. The child, Fred, is doing very well in foster care. Christina is doing extremely well with her aunt, Kathleen, in Tampa. It is agreed that it is in Christina’s best interest to remain in Tampa with her aunt. Angela, James and Kathleen are in constant communication about Christina and these relationships will remain consistent while Christina is in Tampa. Angela has a strong desire to be reunified with her son, Fred and is working on all her case plan tasks to make sure that happens.

Enter in second narrative field

Angela has been very cooperative with services and understands that she needs some help to get her family and her life back on track. She is very confident that the support and services she has been given will continue to make her and her family better. She is committed to making positive changes in her life and for her children.

Select Cultural
Select Strength for statements 1 and 2
Enter narrative in Describe Cultural Factors field

There are no cultural factors that would impact the safety and well-being of the children.
Both children were removed from the mother and placed outside of the home. Christina is doing well with her aunt in Tampa and Fred is doing well in foster care. The removal of the children has given Angela the motivation and dedication to get her life back on track. She is complying with case plan tasks and has recently been employed as a receptionist.

Angela made contact with the Case Manager in January to inform her that she completed her case plan task for obtaining employment. She was employed as a receptionist as of January 5, 2009.

The mother, Angela, has been in constant contact with the Case Manager and called in January to inform her of her job. Angela has been in compliance with all case plan tasks.

There are no immediate safety factors that exist at this time. Both children remain in out-of-home care. The mother is still actively working on her case plan tasks. The goal for Fred remains reunification and the goal for Christina will be changed to Permanent Guardianship with her aunt. Christina’s goal change was recommended by the Case Manager and both parents are in agreement. It will be included in the upcoming JR.
From the **Safety** tab, select **Emerging Dangers** in the **Factors** group box.

In the **Describe Emerging Danger Factors** narrative field, enter:

There are no emerging danger factors present for this family. The mother is complying with her case plan. The father, John FN2, remains incarcerated and both children are doing very well with their current caregivers.

Click **Save**

Click the **Summary** tab

Enter in narrative field, the following narrative:

Since the Initial Family Assessment, Angela has made significant progress on her case plan. She now has a stable job, she completed an outpatient drug treatment program and parenting classes. John FN2 will serve time in jail for his drug charge and it is not known when he will be released. Angela and John have had no contact since the arraignment hearing. John has had no contact with the Case Manager about his case plan tasks and no contact with his child, Fred.

Click **Save**

Click **Close** and return to your desktop

Refresh your FN1, Angela (AD) case

Expand the **Family Assessment** expando

The Updated Family Assessment is in **Pending Status**

Click **Pending Family Assessment** hyperlink

Begins process to update Child Assessment
Updating the Child Assessment

Click the **Child** hyperlink for FN1, Christina (AD)

For the question, *Is the child in out of home placement?*, select **Yes**

Enter Narrative text field, enter:

Christina is currently living with her paternal aunt, Kathleen FN5, and doing very well. Based on Christina’s progress in school, making the A-B honor roll and the fact that she was taken off of the Concerta ADHD medication, both parents and the Case Manager recommend that she remain in Tampa, with a goal change to Permanent Guardianship with her aunt.

Select **Permanency** in the Factors group box

In Describe Efforts to Achieve Permanency text field, enter:

At the upcoming JR it is the recommendation of the Case Manager that Christina’s goal be changed from reunification with the mother to Permanent Guardianship with her aunt, Kathleen FN5. The JR is scheduled for March 3, 2009.

Click the **Well-Being** tab

Click **Health**

Click **Strength for all statements**

In the Describe the Implications of Health Factors text field, enter:

Christina is in good physical health and attends regular health checkups and screenings in Tampa, Florida.

Select **Behavioral Health** on the **Well-Being** tab

For statements 1 and 2, select **Strength**

In the Describe the Implications of Behavioral Health factors text field, enter:

Christina was placed on Concerta for ADHD. However, since her placement in Tampa, she has excelled in school to A-B honor roll status and her physician has discontinued the medication.

Select **Education** on the **Well-Being** tab

For questions 1 and 2, select **Strength**

Select **No** for statement 3 pertaining to Rilya Wilson Act

In the Describe the Implications of Educational factors text field, enter:
Christina was struggling in school in January when there were problems at home. She was removed from her mother’s care and placed in out-of-home care. Since her placement in Tampa, she had a mild adjustment period while residing with her father; however, is currently working very hard to maintain the A-B honor roll she has earned since living with her paternal aunt, Kathleen.

Select Social  →  Select Strength for statements 1, 2, and 3  →  In the Describe the Implications of Social Factors text field, enter:

Christina’s social skills have significantly improved since she moved to Tampa. She has made many friends in the neighborhood and at school. Christina loves living with her paternal aunt, Kathleen. She visits with her father several times per week and both families get together every Sunday for dinner.

Click the Vulnerability tab  →  Select Fragility on Permanency tab  →  Select Strength for statements 1 - 4  →  Select Include in Case Plan for all statements

In the narrative text field

Christina had a runaway/missing child incident in December while living with her father. Christina got off the bus one day and decided that she wanted to go to a friend’s house instead of going home. She was acting out because she wanted to live with her aunt, Kathleen and have the “sister she always wanted”. The runaway episode was resolved and after the completion of a home study, all parties agreed to allow Christina to reside with her aunt, Kathleen.

Select Behavior on the Vulnerability tab  →  For statement 1, select No

In the narrative text field, Other Risk Factors group box, enter

No other risk factors exist that would impact Christina’s vulnerability.

Select Adjustment in Factors group box  →  For statements 1 - 3 select Strength

In Describe the adjustment factors and any change the child wants to make in their family home narrative text field, enter:

Christina initially had a difficult time adjusting and getting along with her stepbrother. However, since her placement with her aunt, she is doing very well. Her father and aunt are very supportive of Christina maintaining a relationship with her mother. Christina speaks to her mother often on the phone and they exchange letters. Christina misses her mother and her brother, Fred; however, knows that they are able to visit each other as much as possible.
In the Case Header group box, select Completed

Click Save -> Click Close

From Family Assessment Participants Tab, click FN1, Fred's (AD) hyperlink and complete the updated child assessment for Fred.
Updating the Adult Assessment

Click the **Adult** hyperlink for FN1, Angela (AD)
Select **Health** and review the **Health** group box on the **Functioning** tab
For statements 1 & 2, select **Strength**
Enter in **Describe the implications of health factors and the impact of any physical disabilities**:

The mother, Angela, is in good health but has agreed to treatment for drug abuse.

Select **Behavioral Health** on the **Functioning** tab
For statements 1-4 select **Strength**
Enter in **Describe the implications of Behavioral Health factors**:

Angela was abusing drugs in the beginning of the investigation. She received support from her mother, Shirley, who moved into Angela’s home to help with the care of the children. Angela agreed to drug treatment, but relapsed with drug abuse which resulted in the removal of the children. Since the removal of the children, Angela completed an 8-week outpatient substance abuse program on 12/8/2006. She enrolled in Positive Parenting Classes and has obtained employment as a receptionist. She has learned how to cope with family and life stressors and has achieved better problem solving skills. Angela has a strong connection with her children and has kept in constant communication with her Case Manager. She hopes to achieve reunification with Fred and is happy that Christina is doing well with her aunt in Tampa.

Select **Intellectual** on the **Functioning** tab
For statement 1, select **Strength**
Enter in narrative field

Angela is of average intelligence. She has an Associates of Arts Degree in Business.

Select **Communication** on the **Functioning** tab
For questions 1 & 2, select **Strength**
Enter in narrative field

Angela communicates well and has been willing to accept and engage in all services that were referred. She has been cooperative and is complying with her case plan tasks.

Click **History** Tab, Select **Abuse**
For questions 1 & 2, select **Strength**
Enter in narrative field

Angela reported that her father was a violent alcoholic; however, her parents have been divorced since she was ten and she has not spoken to her father since. She reported that her mother has always been supportive of her in the past. Angela has no prior history of perpetrating abuse or neglect.

Click **Criminal** on the **History** tab
For questions 1 & 2, select **Strength**
Enter in narrative field

Angela has no criminal history.
Select Financial on History tab → For statement 1, select Strength → For statement 2, select Need → For statements 1 and 2, select Include in Case Plan.

In Describe the individual’s employment history and ability to manage financial resources, enter:

Angela was previously employed at an insurance company until she was laid off in December. When Angela was unemployed, the primary source of income was her paramour selling drugs from the home. Since the removal of the children and the arrest of Angela’s paramour John FN2, she has been complying with all case plan tasks and has obtained a stable income with her new job as a receptionist.

Click Relationships tab → Select Domestic Violence in Factors group box → For statements 1 – 4, select Strength.

In Describe any domestic violence experience as victim or aggressor, enter:

There is no history of domestic violence in this family.

On Relationships tab, select Dynamics in Factors group box → For statement 1, select Need → For statement 2, select Strength → For statement 3, select No.

In Describe the Relationship Dynamics Including Marital History narrative field, enter:

Angela now realizes that she was in an unhealthy and unstable relationship with her paramour John FN2, which greatly affected her children and the way she lived her life. John FN2 was arrested and remains incarcerated and has had no contact with his child, Fred. Angela and the Case Manager have not had contact with John since the arraignment hearing and Angela will never let him back into her life.

Select Support Networks in the Factors group box on the Relationships tab → For statements 1 and 2, select Strength → Enter in narrative field.

Angela has received tremendous support from her mother, Shirley FN1. Angela has made several friends through Positive Parenting and the outpatient drug treatment program. They continue to be supportive of her in the completion of her case plan tasks.

Click Parenting tab → Select Protective Capacities in the Factors group box → For questions 1 - 5 select Strength.
Angela has shown a strong dedicated commitment to improving the lives of her children. She understands how to better take care of herself which will help her parenting skills significantly. She has a stable job with a stable income so she can provide and care for her children appropriately. She is happy that Christina is happy living with her aunt in Tampa and she will make necessary arrangements to visit Christina and provide for her as needed. She is very excited and motivated to complete her case plan and be reunited with her son, Fred. She is happy being single and is focused on herself and her children.

Select **Expectations of Child** in Factors group box → For questions 1 - 3 select Strength → Enter in narrative field

Angela’s parenting skills needed some improvement which was the reason that the Positive Parenting program was one of her case plan tasks. The program has helped her understand how to effectively parent her children. She has an amazing bond with her children that will continue to grow as the family continues to strengthen. According to Angela, she will never let anything or anyone come between her and her children again.

Select Participation in Factors group → Select Strength for Statements 1 - 5 → In Describe participation factors and identify any barriers narrative text field, enter:

Angela understands that the intervention was needed. She understands the severity of the maltreatment and is committed to never letting that happen again. Angela has been active in her service participation and has made timely follow-up with all referrals and is beginning to reflect positive changes while completing her case plan.

Complete the updated adult assessment for John → Once all updates are completed for all children and adults

In Case Header group box, select Completed → Click Save → Click Close

From Options dropdown, select Family Summary on Participants tab

Review information in Family Summary template

Click Close and Return to FSFN → A print option is available

Click Close and Return to Desktop: Refresh the Family Assessment icon
Approving the Updated Family Assessment

From Participants tab of Family Assessment

From Options dropdown box, select Approval

Select Approve

Select Continue, Click Save, Click Close
Creating the FSFN Judicial Review/Task Evaluation

From Desktop, click Create on Menu Bar

Select Case Work from dropdown menu

From Planning dropdown, select Judicial Review/Task Evaluation

Select FN1, Angela (AD) from Cases group box

Click Create

Click the Copy hyperlink next to the Case Plan Task created in Case Planning

Launches Judicial Review/Task Evaluation page

Enter in Describe the reasons and circumstances related to removal or reasons for agency involvement group box

The mother, Angela was under the influence of drugs during her pregnancy with Fred. She and her paramour, Fred’s father, continued to use drugs and partied late at night, leaving the children unattended for long periods of time. The investigation revealed that John FN2 was arrested for selling cocaine to an undercover officer.

In the General Desired Outcomes information group box

Select Progress hyperlink for Substance Abuse issues impact the family, their ability to parent or protective capabilities for FN1, Angela (AD)

Progress Made Pop-Up Box appears stating “This will save the information on the Judicial Review Task Evaluation page, do you want to continue?”

Select Yes

On the Progress Made Pop-Up page

Select Substantial Compliance from the Task Compliance dropdown box

In the Service Delivery dropdown box

Select Received

Enter Discuss compliance regarding completion of tasks and how that relates to behavioral outcome narrative text field

Angela completed 8 weeks of out-patient substance abuse treatment and presented her certificate of completion to the Case Manager on 12/08/2008.
Creating the FSFN Judicial Review/Task Evaluation

Select **Achieved** documenting the level of progress made.

- **Click Save**
- **Click Close**

Select **EACH Progress hyperlink for Angela, John and Christina.**

Repeat the steps until the Progress Pop-Up has been completed for all the listed Needs.

When completing the Progress Hyperlinks for each need statement for each participant, use these values:

- **Angela:** Select **Substantial Compliance** and **Achieved** for all remaining tasks
- **John:** Select **Non-Compliance** and **Insufficient Progress** for all remaining tasks
- **Christina:** Select **Substantial Compliance** and **Achieved** for all remaining tasks

For **Service Delivery** dropdown box: Select **Received** for Angela and Christina
Select **Not Available** for John
The mother, Angela, obtained a job in December and pays child support every month for both of her children. James FN3, Christina’s father, agreed to pay for Christina’s weekly therapy sessions.

Enter in **What has been done to assist the foster family or a legal custodian in an effort to address the needs of the child?** text field

The foster mother has provided transportation for Fred to all medical appointments and visitations with the mother, Angela. The foster mother also provides transportation to and from daycare on a daily basis. Christina’s father, James provides transportation to all of her appointments and supports any other of Christina’s needs.

In **Fees assessed and collected** text field

No fees have been assessed or collected as of this date.

Enter in **Barriers to achieving measurable desired behavioral outcomes** text field

The father, John FN2, is currently incarcerated and has made no attempt to contact the Case Manager regarding Fred’s health, safety and well-being. John has not paid child support in 6 months.

Click **Save**

Click on the **Family Interaction** tab

In the **Visitation Plan Outcome** group box, enter

The mother visits Fred every Thursday from 4:00 pm to 6:00 pm. Fred’s foster mother supervises the visitation. Angela has been able to have face-to-face contact with Christina every two months with the help of her mother, Shirley FN1, Christina’s father, James FN3, James and paternal aunt, Kathleen. John FN2 has had no contact with Angela or Fred since the arraignment hearing and expressed no desire to be reunified with Fred. John is still in jail, awaiting trial. A date for John FN2 to be released from jail has not been determined.
The foster mother has been supervising the visits between Fred and Angela. The foster mother reports that Fred has a strong bond with his mother and that Angela has shown significant improvement in her parenting skills. The foster mother supports the reunification of Fred and Angela and is willing to assist in the transition as much as possible. All parties are in agreement that it is in Christina’s best interest to remain in Tampa with her paternal aunt. Angela visits with Christina as often as possible thanks to the support she receives from Kathleen and James.

In the Household Barriers group box, Select No to, Have there been any changes to the household composition since the last review?

Click Save to update the JR/Task Evaluation, Click the Recommendations tab.

In the first required field, documenting reasonable efforts make to finalize the permanency plan in effect, enter:

All appropriate referrals were made for services for the mother and father on 09/08/2008. Angela’s progress has been closely monitored. Referrals for therapy were made for Christina. The foster mother agreed to supervise visits between Fred and Angela. Angela obtained stable employment in January, 2009. The duration and number of visits has greatly increased. The mother contacts the Case Manager on a weekly basis to update her progress.

In the second required field, documenting safety and appropriateness of the child’s current placement or living arrangement, enter:

Fred is placed in licensed care and has been with the same foster mother since the time of his removal. He attends daycare everyday and is doing very well with this foster mother. The foster mother complies with all responsibilities to assist with the case plan tasks. She transports Fred to and from daycare, and medical appointments as needed. The foster mother also supervised the weekly visitation between Fred and the mother, Angela. Christina is doing very well in her placement with her Aunt Kathleen. Christina is well bonded with her aunt and cousin and happy to be living near her father and his family.

Select Substantial Compliance from the Overall Compliance dropdown box for Angela and Christina.

Select: Not Applicable for Fred
Select: Non-Compliance for FN2, John (AD)

In the Case Worker’s Recommendation to the Court narrative box, enter:

It is recommended that Fred be reunified with his mother, Angela and that Christina’s goal be changed from reunification to permanent guardianship with her paternal aunt, Kathleen FN5, with six months of supervision.

Select Completed in the JR/Task Evaluation group box before sending to Supervisor for Approval.

Click Save, Click Close to return to the Desktop.
Judicial Review/Goal Evaluation

1. From the Desktop page, click Create on menu bar.
2. Select Case Work from dropdown menu.
4. From the Case group box, select FN1, Angela (AD).
5. From the Case Participants group box, select FN1, Christina (AD).
6. Click Create.
7. In the General Information header group box, select Review Type: Judicial Review.
8. In the Date of Hearing/Review field in Legal group box, enter: 03/03/2009.
10. In the first narrative text box, enter:

Christina will be present at the hearing. She will travel from Tampa with her paternal aunt and father.

The second box is for documenting the reason for the child not being notified of the hearing.

12. Select Yes to: "Does the child's case plan involve an out-of-home placement?"
Review Placement Proximity

In the Placement Proximity group box

Select: No for questions 1 and 2
Select: Yes for questions 3, 4 and 5

In the narrative text box providing supportive information to the above questions, enter:

Christina was placed in Hillsborough County with her father. There was a change of custody in December and Christina now lives with her paternal aunt. The paternal aunt, Kathleen FN5, and the father, James FN3, live in the same neighborhood, allowing Christina to remain in the same school since her placement in Tampa. Christina has constant communication with her mother and her brother, Fred, and visits them monthly.

In the narrative text box describing the reasonable efforts to prevent removal or reunify the family or achieve the permanency goal, enter:

Angela FN1 agreed to keep Fred’s father, John FN2, out of the home and to participate with Non-Judicial In-Home Services; however, after her drug evaluation she relapsed and left her children in the grandmother’s care, failing to return for one week. Angela is currently working on her case plan and she wants to be reunified with Fred. She has agreed to the Case Manager’s recommendation of Christina’s goal change to permanent guardianship with the paternal aunt.

Review the Residential Group Care box

Select: No for questions 1-4

Click Save

Click the Permanency Plan Information tab

In the Date of last Permanency Staffing

Enter: 02/03/2009

In the Date by Which Next Permanency Hearing is due

Enter: 09/03/2009

In the Child’s Current Court Approved Permanency Goal dropdown box

Select: Reunification with Parent

Review Permanency considerations made at 12 months group box
Select “Child is placed with a fit and willing relative”

In the narrative text field, enter:

Christina was placed with her paternal aunt, Kathleen FN5, in December and the placement is stable. All parties agree that it is in Christina’s best interest to remain with her aunt maintain visitation with the father and mother.

Click the Independent Living tab

Select: “The child is not yet 13 years of age or the child is not in licensed foster care”

On the Recommendations tab, click the expando to the left of Court Orders

In the Child supporting information text box, enter

Since Christina was placed with her aunt, her behavior has significantly improved. She loves going to school and she has positive interactions with her classmates. She attends tutoring three times per week. Christina is well adjusted and happy living with her aunt and visits with her father and father’s family regularly, in addition to weekly Sunday dinners. Christina currently visits her mother and brother on a monthly basis.
In the **Caregiver** supporting information narrative text box, enter:

The paternal aunt, Kathleen, has complied with all necessary court orders and has been supportive of the permanency plan for Christina. Christina is doing very well with her aunt and all parties agree it is in her best interest to remain residing in the aunt’s residence.

Click the expando to the left of “**The extent of efforts to include other service providers in meeting any special needs of the child**”

In the supporting information narrative text box, enter:

Christina has bonded with her aunt, Kathleen FN5, and wishes to remain in Tampa, residing in the aunt’s home, in close proximity to her father and his family.

Click the expando to the left of the third statement, “**If this is the initial judicial review, and sufficient progress has not been made toward achieving the primary permanency goal, describe efforts made to achieve or implement a concurrent permanency goal.**”

In the supporting information narrative text box, enter:

There is no need for a concurrent permanency goal as the child is doing well with the paternal aunt and all parties are in agreement with the new goal of Permanent Guardianship.

Click the expando next to the **Events Summary**

In the supporting information text box, enter:

Since the Disposition hearing, Angela has substantially complied with her case plan. Christina has become very bonded with her aunt, Kathleen FN5, and wishes to remain residing with her aunt in Tampa, which is also in close proximity to her father and his family. It is recommended that Christina’s goal be changed to Permanent Guardianship with her paternal aunt with 6 months supervision.
In the **Rilya Wilson Act** group box

Select **No** for statement, “*Is the child between the ages of 3 and 6 years and under the supervision of the Department?***”

In the **General Information header** group box

Select **Completed** to verify all work is complete and ready to be sent for supervisory approval

Click **Save**

Click **Close and Return to the Desktop**

Complete the JR Goal Evaluation for child Fred as you did for Christina; remember that Fred’s goal is Reunification which is different than Christiana’s
Approving the Judicial Review/Task and Goal Evaluation

From the Desktop

Click the Options dropdown box

Select: Approval
Click Go

Click Save and Close to return back to Desktop

Expand
- FN1, Angela (AD) case
- Planning icon
- Case Plan Task and Case Plan Goal icon for FN1, Fred (AD)
- Select the hyperlink Judicial Review/Goal Evaluation

Approval must be routed to a supervisor for second level of Approval to be completed

From the Desktop

Click Save and Close to go back to Desktop

Select: Approval
Click Continue

Expand
- FN1, Angela (AD) case
- Planning icon
- Case Plan Task icon
- Case Plan Goal for FN1, Christina (AD)
- Select the hyperlink Judicial Review/Goal Evaluation

Approval must be routed to a supervisor for second level of Approval to be completed
**Approving the Judicial Review/Task and Goal Evaluation**

Once Supervisor approval is completed, the Judicial Review Task Evaluation must be approved.

- **From the Desktop**
- **From the Options dropdown box**
- **Click Go**
- **Once Template is launched, review information**

Select the text Judicial Review

Select Close and Return to FSFN

Select Approval
Select Approve
Select Continue

Approval must be routed to a supervisor for second level of Approval to be completed.

Selecting:
FN1, Angela (AD) Case Planning Icon
Case Plan Task
Select: Judicial Review/Task Evaluation for the FN1, Angela (AD) Family

CM 125_OAP_FSFN_PG July 2013 (CM 123 OAP FSFN) 21
Module 4: Judicial Review Social Study/Case Plan Update
FN1, Angela JRRS/CPU

IN THE CIRCUIT COURT (USER MUST ENTER) JUDICIAL CIRCUIT IN
AND FOR (USER MUST ENTER) COUNTY, FLORIDA

FAMILY LAW DIVISION (this is a dropdown box that populates from the case plan)

IN THE INTEREST OF:  CASE NUMBER:
User must enter:  User must enter
FN1, Christina
FN1, Fred
Minor Child

JUDICIAL REVIEW SOCIAL STUDY / CASE PLAN UPDATE

☐ This is also a Permanency Review

DATE OF CURRENT JUDICIAL REVIEW HEARING:  03/03/2009 User Entered
Date of last judicial review hearing:
Date this JRSSR prepared:  2/12/2009 User Entered

I. Judicial History

A. Date of entry of Order of Adjudication:  User Entered: 10/10/2008
B. Date of entry of Order Accepting Case Plan:  User Entered: 10/10/2008
C. Date of entry of Final Disposition Order:  User Entered: 10/10/2008

II. Significant changes since last JR: User Entered: This is the initial Judicial Review

III. Current Court Approved Primary Permanency Goal: Comes from FSFN Legal or User Entered if not pre-populated

<table>
<thead>
<tr>
<th>Participant</th>
<th>Goal</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

IV. Current Placement of Children

<table>
<thead>
<tr>
<th>Child Name</th>
<th>Service Category</th>
<th>Service Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre Populates from the FSFN Placement</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

V. Summary of Recommendations of Department: User Entered- The Dept recommends that Christina’s goal change to permanent guardianship with the paternal aunt and Fred be reunited with his mother, Angela.
NOTICE TO PARENTS
THE JUDICIAL REVIEW HEARING IS VERY IMPORTANT. AT THE JUDICIAL REVIEW
THE COURT WILL DECIDE WHETHER TO RETURN YOUR CHILD(REN) TO YOU, OR TO
OTHER FAMILY MEMBERS/NON-RELATIVES, LEAVE YOUR CHILD(REN) IN FOSTER
CARE, OR START PROCEEDINGS TO CONSIDER ADOPTION FOR YOUR CHILD(REN).

YOU HAVE A RIGHT TO OBTAIN YOUR OWN ATTORNEY FOR THE JUDICIAL REVIEW
AND ALL SUBSEQUENT HEARINGS. YOU HAVE A RIGHT TO REQUEST THE COURT
APPOINT AN ATTORNEY IF YOU CANNOT AFFORD TO HIRE AN ATTORNEY. THIS
RIGHT CONTINUES AT EACH AND EVERY STAGE OF A DEPENDENCY PROCEEDING,
EVEN IF YOU HAVE PREVIOUSLY WAIVED THIS RIGHT.

VI. Parties / Participants to the Case Plan

| FN, Angela | Mother | FN5, Kathleen | Caregiver |
| FN2, John | Father | Guardian ad litem |
| FN3, James | Father | Family Care Counselor |
| | Father | Other |

VII. Case Plan Tasks

A. Progress

► Mother

Identified Problem: The mother, Angela, was under the influence of drugs during her
pregnancy with Fred. She and her paramour continued to use drugs and party late at night
leaving the children unattended for long periods of time.

Desired Measurable Behavioral Outcome: The mother will provide her children with an
environment that is free of substance abuse.

Specific Task: The mother, Angela FN1, will participate in weekly outpatient substance abuse treatment. If the mother
misses one appointment for outpatient treatment she will participate in inpatient treatment until it is deemed no longer
necessary.

Specific Task End Date: 09/03/2009

Task compliance
☒ Substantial Compliance
☐ Partial Compliance
☐ Non Compliance
☐ Applicable

Service Delivery: Received

Completion of task and how it relates to desired measurable behavioral outcome:
Angela FN1 has completed 8 weeks of outpatient substance abuse treatment and presented
her certificate of completion to the Case Manager on 12/05/2008.

☒ Achieved
☐ Sufficient Progress
☐ Insufficient Progress
### FN1, Angela

**Identified Problem:** Angela FN1 has been unemployed since December of 2007 and has been unable to financially support herself and her children. The family’s only source of income came from John FN2 selling narcotics from the home.

**Desired Measurable Behavioral Outcome:** Angela FN1 will be able to financially provide for her children’s needs.

**Specific Task:** Angela FN1 will obtain and maintain a verifiable source of income sufficient to meet her children’s needs.  

<table>
<thead>
<tr>
<th>Specific Task End Date:</th>
<th>09/03/2009</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Task compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Substantial Compliance</td>
</tr>
<tr>
<td>☐ Partial Compliance</td>
</tr>
<tr>
<td>☐ Non Compliance</td>
</tr>
<tr>
<td>☐ Not Applicable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service Delivery:</th>
<th>Received</th>
</tr>
</thead>
</table>

**Completition of task and how it relates to desired measurable behavioral outcome:** Angela FN1 obtained employment as a receptionist and began work on 12/15/2008. She works Monday through Friday, 9:00am-5:00pm.

<table>
<thead>
<tr>
<th>Achieved</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Achieved</td>
</tr>
<tr>
<td>☐ Sufficient Progress</td>
</tr>
<tr>
<td>☐ Insufficient Progress</td>
</tr>
</tbody>
</table>

---

### FN1, Angela

**Identified Problem:** Angela FN1 allowed John FN2 to sell narcotics from the home. Angela FN1 admitted to using cocaine and neglecting to supervise her children.

**Desired Measurable Behavioral Outcome:** Angela FN1 will provide her children with a living environment that is free of substance exposure and will provide her children with age appropriate adult supervision.

**Specific Task:** Angela FN1 will complete a parenting class with 100% attendance and will demonstrate the skills learned during supervised visitation with her children.  

<table>
<thead>
<tr>
<th>Specific Task End Date:</th>
<th>09/03/2009</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Task compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Substantial Compliance</td>
</tr>
<tr>
<td>☐ Partial Compliance</td>
</tr>
<tr>
<td>☐ Non Compliance</td>
</tr>
<tr>
<td>☐ Not Applicable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service Delivery:</th>
<th>Received</th>
</tr>
</thead>
</table>

**Completition of task and how it relates to desired measurable behavioral outcome:** Angela FN1 enrolled in a 6 week Positive Parenting Class and completed the course on 1/16/2008. She has presented her certificate of completion to her Case Manager.

<table>
<thead>
<tr>
<th>Achieved</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Achieved</td>
</tr>
<tr>
<td>☐ Sufficient Progress</td>
</tr>
<tr>
<td>☐ Insufficient Progress</td>
</tr>
<tr>
<td>FN2, John</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Identified Problem: John FN2 has numerous drug related arrests.</td>
</tr>
<tr>
<td>Desired Measurable Behavioral Outcome: John FN2 will provide Fred with an environment that is free of illegal activities.</td>
</tr>
<tr>
<td>Specific Task: John FN2 will not engage in illegal activities particularly selling narcotics or any other drug related offenses.</td>
</tr>
<tr>
<td>Task compliance</td>
</tr>
<tr>
<td>□ Substantial Compliance</td>
</tr>
<tr>
<td>□ Partial Compliance</td>
</tr>
<tr>
<td>☒ Non Compliance</td>
</tr>
<tr>
<td>Not Applicable</td>
</tr>
<tr>
<td>Service Delivery: Received</td>
</tr>
<tr>
<td>Completion of task and how it relates to desired measurable behavioral outcome: John FN2 has not complied with any case plan tasks. He remains incarcerated and a release date has not been determined. John, awaiting a trial date, has had no contact with Fred. John has expressed no desire to have a relationship with his son and will have no visitation with Fred until the completion of a drug assessment and treatment program.</td>
</tr>
<tr>
<td>□ Achieved</td>
</tr>
<tr>
<td>□ Sufficient Progress</td>
</tr>
<tr>
<td>☒ Insufficient Progress</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FN2, John</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identified Problem: John is currently unemployed. His only source of income was the selling of narcotics from the home.</td>
</tr>
<tr>
<td>Desired Measurable Behavioral Outcome: John FN2 will financially provide for Fred's needs.</td>
</tr>
<tr>
<td>Specific Task: John FN2 will obtain and maintain a verifiable source of income sufficient to provide for Fred.</td>
</tr>
<tr>
<td>Task compliance</td>
</tr>
<tr>
<td>□ Substantial Compliance</td>
</tr>
<tr>
<td>□ Partial Compliance</td>
</tr>
<tr>
<td>☒ Non Compliance</td>
</tr>
<tr>
<td>□ Not Applicable</td>
</tr>
<tr>
<td>Service Delivery: Received</td>
</tr>
<tr>
<td>Completion of task and how it relates to desired measurable behavioral outcome: John FN2 is currently incarcerated, therefore unemployed. John has not paid child support for 6 months.</td>
</tr>
<tr>
<td>□ Achieved</td>
</tr>
<tr>
<td>□ Sufficient Progress</td>
</tr>
<tr>
<td>☒ Insufficient Progress</td>
</tr>
<tr>
<td>FN2, John</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td><strong>Identified Problem:</strong> John FN2 was selling narcotics from the home putting Fred at risk for threat of harm.</td>
</tr>
<tr>
<td><strong>Desired Measurable Behavioral Outcome:</strong> John FN2 will provide Fred with a living environment that is free of substance exposure and will provide Fred with age appropriate adult supervision.</td>
</tr>
<tr>
<td><strong>Specific Task:</strong> John FN2 will complete a parenting class with 100% attendance and will demonstrate the skills learned during supervised visitation with Fred.</td>
</tr>
<tr>
<td>☐ Task compliance</td>
</tr>
<tr>
<td>☐ Substantial Compliance</td>
</tr>
<tr>
<td>☐ Partial Compliance</td>
</tr>
<tr>
<td>✗ Non Compliance</td>
</tr>
<tr>
<td>Not Applicable</td>
</tr>
<tr>
<td><strong>Specific Task End Date:</strong> 09/03/2009</td>
</tr>
<tr>
<td><strong>Service Delivery:</strong> Received</td>
</tr>
<tr>
<td><strong>Completion of task and how it relates to desired measurable behavioral outcome:</strong> John FN2 is currently in jail and there are no parenting classes offered at the facility where he is currently incarcerated. John does not have a desire to be reunified with his son and has stated several times that he never wanted to be a father. John FN2 does not know when he will be released from jail.</td>
</tr>
<tr>
<td>☐ Achieved</td>
</tr>
<tr>
<td>☐ Progress</td>
</tr>
<tr>
<td>✗ Insufficient Progress</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FN1, Christina</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Identified Problem:</strong> Christina’s academic performance has dropped and she has become withdrawn in the school environment.</td>
</tr>
<tr>
<td><strong>Desired Measurable Behavioral Outcome:</strong> Christina will be able to concentrate on her school work and actively participate in class.</td>
</tr>
<tr>
<td><strong>Specific Task:</strong> Christina will meet with her guidance counselor when she feels upset. Mr. James FN3 will assist Christina with her school work.</td>
</tr>
<tr>
<td><strong>Specific Task End Date:</strong> 09/03/2009</td>
</tr>
<tr>
<td><strong>Task compliance</strong></td>
</tr>
<tr>
<td>✗ Substantial Compliance</td>
</tr>
<tr>
<td>☐ Partial Compliance</td>
</tr>
<tr>
<td>☐ Non Compliance</td>
</tr>
<tr>
<td>☐ Not Applicable</td>
</tr>
<tr>
<td><strong>Service Delivery:</strong> Received</td>
</tr>
<tr>
<td><strong>Completion of task and how it relates to desired measurable behavioral outcome:</strong> Since Christina was placed with her aunt, her behavior has significantly improved. She loves going to school again and interacts with all her classmates in a positive manner. She receives tutoring afterschool three times a week and her grades have improved. The relationship Christina has with her father, stepmother and stepbrother has gotten much better and the family continues counseling once a month. Christina is well adjusted and very happy living with her aunt and cousin. She has regular contact with her mother and visits with Angela at least once every 2 months.</td>
</tr>
<tr>
<td>✗ Achieved</td>
</tr>
<tr>
<td>☐ Sufficient Progress</td>
</tr>
<tr>
<td>☐ Insufficient Progress</td>
</tr>
</tbody>
</table>
FN1, Christina

Identified Problem: Christina has become withdrawn and has recently fought with another child at school.

Desired Measurable Behavioral Outcome: Christina will learn to interact better with her peers.

Specific Task: Christina will attend weekly counseling to address the effects of maltreatment and her behavioral problems.

Specific Task End Date: 09/03/2009

Task compliance
- [x] Substantial Compliance
- [ ] Partial Compliance
- [ ] Non Compliance
- [ ] Not Applicable

Service Delivery: Received

Completion of task and how it relates to desired measurable behavioral outcome: Christina continues her individual counseling sessions once a week at school. The school therapist has recommended that her therapy be reduced to every two weeks due to her progress. She is adjusting wonderfully with her Aunt Kathleen and continues to participate in extra curricular activities. Christina visits with her father, stepmother and stepbrother every Sunday for dinner. She is bonded with her mother, Angela and her brother, Fred and sees them once every 2 months.

- [x] Achieved
- [ ] Sufficient Progress
- [ ] Insufficient Progress

B. Reason for Agency Involvement

The mother, Angela FN1, was under the influence of drugs during her pregnancy with Fred. She and her paramour continue to use drugs and party late at night leaving the children unattended for long periods of time. The investigation revealed that John FN2 was arrested for selling cocaine to an undercover officer.

C. Resources and Barriers

1. Level of material and monetary support provided by the parents: The mother, Angela, obtained a job in December and pays child support every month for both of her children. James FN3, Christina’s father, agreed to pay for Christina’s weekly therapy sessions.

2. Assistance provided to the Foster Parents or Legal Custodian to address the needs of the child: Fred’s foster mother was provided with respite care from 1/21/2009-1/24/2009. The foster mother has provided transportation for Fred to all medical appointments and visitsations with the mother, Angela. The foster mother also provides transportation to and from daycare on a daily basis.

3. Fees assessed and collected: No fees have been assessed or collected as of this date.

4. Barriers to achieving desired measureable behavioral outcomes. This includes the status of any pending diligent search: The father, John FN2, is currently incarcerated and has made no attempt to contact the Case Manager regarding Fred’s health, safety and well-being. John has not paid child support in 6 months.
D. Family Interaction

1. Frequency, results and duration of the child/parent/sibling visitation, if any, and agency recommendation for expansion or restriction of future visitation. Reason for any non-compliance: The mother visits Fred every Thursday from 4:00pm to 6:00pm. Fred’s foster mother supervises the visitation. Angela has been able to have face-to-face contact with Christina every two months with the help of her mother, Shirley FN1, and Christina’s father, James FN3, and paternal aunt, Kathleen. John FN2 has had no contact with Angela or Fred since the arraignment and expressed no desire to be reunified with Fred. John is still in jail, awaiting his trial. A date for John FN2 to be released from jail has not been determined.

2. Statement from current caregiver regarding any material evidence concerning return of the child to the parent(s): The foster mother has been supervising the visits between Fred and Angela. The foster mother reports that Fred has a strong bond with his mother and that Angela has shown significant improvement in her parenting skills. The foster mother supports the reunification of Fred and Angela and is willing to assist in the transition as much as possible.

3. Changes to the household composition since the last review  
   □ Yes  ❌ No

4. Describe the changes and the impact to household since the last review: This is the first Judicial Review.

E. Caseworker Recommendations to the Court

Caseworker Recommendations to the Court: It is recommended that Fred be reunified with his mother, Angela, and that Christina’s goal be changed from reunification to permanent guardianship with her paternal aunt, Kathleen Cooper, with 6 months of supervision.

F. Overall Compliance

<table>
<thead>
<tr>
<th>Participant</th>
<th>DOB</th>
<th>Overall Compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>FN1, Angela</td>
<td>07/15/1981</td>
<td>Substantial Compliance</td>
</tr>
<tr>
<td>FN1, Christina</td>
<td>04/26/1998</td>
<td>Substantial Compliance</td>
</tr>
<tr>
<td>FN2, John</td>
<td>05/16/1980</td>
<td>Non-Compliance</td>
</tr>
</tbody>
</table>
### VIII. Judicial Review Goals

<table>
<thead>
<tr>
<th>FN1, Fred</th>
<th>Child’s DOB: 08/20/2008</th>
<th>FSFN Task ID:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adjudication Date: 10/10/2008</td>
<td>Review Type: Judicial Review</td>
</tr>
</tbody>
</table>

**American Indian/Alaskan Native Designated Tribal Representative:**

**Mothers Name:** FN1, Angela

**Fathers Name (Birth):** FN2, John

**Fathers Name (Legal):**

**Guardian/Legal Custodian Name:**

**Date of Last Permanency Staffing:** 12/22/2008

**Date of Last Judicial Review:**

**Date by which next Permanency Hearing due:**

**Child’s current court approved Permanency Goal:** Reunification

**Child’s current court approved Concurrent Goal (if applicable):**

If this is the initial Judicial review and sufficient progress has not been made toward achieving the permanency goal, identify efforts that will be made to implement a concurrent permanency goal. There is no need for a concurrent permanency goal. The mother continues to comply with the case plan and shows a strong desire to be reunified with her son, Fred.
<table>
<thead>
<tr>
<th>Current Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does the child’s case plan involve an out-of-home placement:</td>
</tr>
<tr>
<td>Date child removed from his/her home: Pre-populates from FSFN Removal Episode</td>
</tr>
<tr>
<td>Placement begin date: Pre-populates from the FSFN Placement record</td>
</tr>
<tr>
<td>Type of placement: Pre-populates from the FSFN Placement record</td>
</tr>
<tr>
<td>Length of time child has been in current placement (months): Pre-populates from the FSFN Placement record</td>
</tr>
<tr>
<td>Length of time of this Removal Episode (months): Pre-populates from the FSFN Removal Episode</td>
</tr>
<tr>
<td>Child is placed with all siblings in out-of-home care?</td>
</tr>
<tr>
<td>Describe the plan to place siblings together or reasons for separation: Christina is placed with her father in Hillsborough County. Fred is placed in licensed care. There are no relatives available to care for Fred.</td>
</tr>
<tr>
<td>Placement in close proximity to the child’s home:</td>
</tr>
<tr>
<td>Child’s placement takes into account proximity to the school in which the child is enrolled at time of placement.</td>
</tr>
<tr>
<td>Entry into out-of-home care resulted in a change in educational setting</td>
</tr>
<tr>
<td>Placement supports the level of contact to the parents that is deemed appropriate:</td>
</tr>
<tr>
<td>Placement is the least restrictive, most family like setting consistent with child’s best interest and special needs:</td>
</tr>
<tr>
<td>Supporting information regarding above statements: Fred is placed in licensed care and has been with the same foster mother since the time of his removal. He attends daycare everyday and is doing very well with this foster mother. The foster mother complies with all responsibilities to assist with the case plan tasks. She transports Fred to and from daycare, and medical appointments as needed. The foster mother also supervised the weekly visitation between Fred and the mother, Angela.</td>
</tr>
</tbody>
</table>
## Residential Group Care

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the child 11 years or older</td>
<td>☐</td>
<td>☑</td>
</tr>
<tr>
<td>Has the child been in licensed family foster care for 6 months or longer?</td>
<td>☐</td>
<td>☑</td>
</tr>
<tr>
<td>Has the child been moved more than once while in licensed family foster care?</td>
<td>☐</td>
<td>☑</td>
</tr>
<tr>
<td>Does the child meet criteria for extraordinary needs as described in s.409.1676 (2)(a), Florida Statutes?</td>
<td>☐</td>
<td>☑</td>
</tr>
<tr>
<td>If yes to the four questions above, has the child been assessed for placement in licensed residential group care?</td>
<td>☐</td>
<td>☑</td>
</tr>
</tbody>
</table>

If the child has not been assessed for placement in licensed residential group care explain why not.

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Did the assessment recommend residential group care?</td>
<td>☐</td>
<td>☑</td>
</tr>
<tr>
<td>If the assessment recommended residential group care, is the child in residential group care?</td>
<td>☐</td>
<td>☑</td>
</tr>
</tbody>
</table>

If the assessment recommended residential group care, and the child is not in residential group care explain why not.

### Permanency Considerations at 12 months (or 12 of 22 months)

- **Child is placed with a fit and willing relative**

  Supporting Information: The mother, Angela, continues to comply with all of her case plan tasks and the goal for Fred remains reunification. The mother and Fred are very bonded and have a strong attachment to each other.

- **Termination of parental rights/adoPTION** is not in the best interest of the child

  Supporting Information: The mother, Angela, continues to comply with all of her case plan tasks and the goal for Fred remains reunification. The mother and Fred are very bonded and have a strong attachment to each other.

- **Reasonable efforts to safely reunify the child** have not been made

  Supporting Information:

  - Grounds for involuntary TPR do not exist

  Supporting information:

  - Reasonable efforts to prevent removal or reunify the family or achieve the permanency goal

  Supporting Information: Angela agreed to keep the paramour, John FN2, out of the home and also agreed to participate in Non-Judicial In-Home Services. However, after her drug evaluation she relapsed, left her children in the grandmother's care, failing to return for one week. Angela is currently working on her case plan and she wants to be reunited with Fred. She has agreed to the Case Manager's recommendation of Christina's goal change to permanent guardianship with the paternal aunt.
### Rilya Wilson Act Compliance

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the child between the ages of 3 to 6 years and under the supervision of the Department?</td>
<td>☐Yes</td>
<td>☒No</td>
</tr>
<tr>
<td>Has the child been attending the daycare facility for the required 5 days a week or as otherwise ordered by the Court?</td>
<td>☐Yes</td>
<td>☐No</td>
</tr>
<tr>
<td>If not attending as required explain the number and reasons for excused and unexcused absences:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If there were any lapses in the child’s daycare attendance did the day care provide proper notification to the Department or contract provider?</td>
<td>☐Yes</td>
<td>☐No</td>
</tr>
<tr>
<td>If there were two consecutive unexcused absences or seven consecutive excused absences reported was the required follow-up visit to the child’s residence completed?</td>
<td>☐Yes</td>
<td>☐No</td>
</tr>
</tbody>
</table>

Outcome of the visit or explanation why visits were not made:

### Independent Living Services (Applies only to children in licensed care ages 13-17)

<table>
<thead>
<tr>
<th>Question</th>
<th>Date Referred:</th>
<th>Date Completed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Child is not yet 13 years of age or is not in licensed foster care.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>☐ Child is 13+ years of age and has been referred for Independent Living.</td>
<td>Date Referred:</td>
<td>Date Completed:</td>
</tr>
</tbody>
</table>

For a youth who has reached 13 years of age but is not yet 18 years of age, the adequacy of the youth’s preparation for adulthood and living independently:

<table>
<thead>
<tr>
<th>Question</th>
<th>Date Completed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Independent Living Assessment was completed:</td>
<td></td>
</tr>
<tr>
<td>Results of the independent living assessment, and any specific needs or services needed and the status of the delivery of services:</td>
<td></td>
</tr>
<tr>
<td>☐ Independent Living staffing completed:</td>
<td></td>
</tr>
</tbody>
</table>

Information discussed at required staffing, including services provided and youth’s progress toward developing Independent Living skills:
### Education and Career Path

- □ Attending a 4 year college, or university or community college plus university or a military academy
- □ Receiving a two year post secondary degree
- □ Attaining a post secondary career or technical certificate
- □ Beginning immediate employment, including apprenticeship after completion of a high school diploma or its equivalent or enlisting in the military

**Youth’s progress and any obstacles the youth is facing in achieving their educational and career path:**

An updated case plan been provided to the court that includes specific information related to independent living services that have been provided since the youth's 13th birthday, or since the date the child came into foster care. □ Yes  □ No

If child 17 years of age or older? □ Yes  □ No

If so child has been provided with the following:
- □ A current Medicaid card
- □ A certified copy of his or her birth certificate
- □ A valid driver's license or Florida identification card
- □ Information relating to Social Security Insurance benefits, if the child is eligible for such benefits
- □ A full accounting of Social Security Insurance benefits and information on how to access those funds, if the child has received these benefits and they are being held in a trust
- □ Information and training related to budgeting skills, interviewing skills, and parenting skills
- □ All relevant information related to the Road-to-Independence Program, including, but not limited to, eligibility requirements and forms necessary to apply
- □ Has an open bank account or identification necessary to open such an account, and has been provided with necessary banking skills
- □ Information on public assistance and how to apply
- □ A clear understanding of where he or she will be living on his or her 18th birthday, how living expenses will be paid and what educational program or school he or she will be enrolled in
- □ Notice of the right to petition for the court’s continuing jurisdiction for 1 year after the youth’s 18th birthday and with information on how to obtain access to the court
- □ Has been encouraged to attend all judicial review hearings occurring after his or her 17th birthday

If this is the Judicial Review hearing that is being held within the month that begins the 6 month period before the youth’s 18th birthday, when placed in licensed foster care, has a plan to outline the youth’s transition to adulthood been submitted to the court? □ Yes  □ No
## Participation

<table>
<thead>
<tr>
<th>Was child notified of hearing?</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
</table>

Describe child’s plan for participation at hearing: Fred is too young to attend the hearing.

If child is not attending state reason:

Compliance with court orders:

Child: FN1, Fred

The foster mother has complied with all necessary court orders and has been supportive of the permanency plan for Fred. Fred is doing very well in licensed care but it is in the child’s best interest to be reunified with his mother. All parties are in agreement with the permanency plan. Fred visits with his sister, Christina every 2 months.

Caregiver:
The foster caregiver has complied with court orders and agrees with the permanency plan for Christina.

## Reasonable Efforts

<table>
<thead>
<tr>
<th>FN1, Christina</th>
<th>Child’s DOB: 04/26/1998</th>
<th>FSFN Task ID: 3600721</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjudication Date:</td>
<td>Review Type: Judicial Review</td>
<td></td>
</tr>
<tr>
<td>10/10/2008</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

American Indian/Alaskan Native: □

Designated Tribal Representative:

Mothers Name: FN1, Angela

Fathers Name (Biological): FN3, James

Fathers Name (Legal):

Guardian/Legal Custodian Name:

Date of Last Permanency Staffing: 12/22/2008

Date of Last Judicial Review:

Date by which next Permanency Hearing due:

Child’s current court approved Permanency Goal: Guardianship

Child’s current court approved Concurrent Goal (if applicable):

If this is the initial Judicial review and sufficient progress has not been made toward achieving the permanency goal, identify efforts that will be made to implement a concurrent permanency goal. There is no need for a concurrent permanency goal, the child is doing well with the paternal aunt and all parties are in agreement with the new goal of Permanent Guardianship.
## Current Placement

<table>
<thead>
<tr>
<th>Does the child’s case plan involve an out-of-home placement?</th>
<th>☒ Yes  ☐ No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date child removed from his/her home:</td>
<td>Pre-populates from FSFN Removal Episode</td>
</tr>
<tr>
<td>Placement begin date: Pre-populates from FSFN Placement Record</td>
<td></td>
</tr>
<tr>
<td>Type of placement: Pre-populates from FSFN Placement Record</td>
<td></td>
</tr>
<tr>
<td>Length of time child has been in current placement (months): Pre-populates from FSFN Placement Record</td>
<td></td>
</tr>
<tr>
<td>Length of time of this Removal Episode (months): Pre-populates from FSFN Removal Episode</td>
<td></td>
</tr>
<tr>
<td>Child is placed with all siblings in out-of-home care?</td>
<td>☒ Yes  ☐ No  ☐ N/A (Child has no siblings or no siblings in care)</td>
</tr>
</tbody>
</table>

Describe the plan to place siblings together or reasons for separation:
Christina is placed with her father in Hillsborough County. Fred is placed in licensed care. There are no relatives available to care for Fred.

<table>
<thead>
<tr>
<th>Placement in close proximity to the child’s home:</th>
<th>☐ Yes  ☒ No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child’s placement takes into account proximity to the school in which the child is enrolled at time of placement.</td>
<td>☐ Yes  ☒ No</td>
</tr>
<tr>
<td>Entry into out-of-home care resulted in a change in educational setting</td>
<td>☒ Yes  ☐ No</td>
</tr>
<tr>
<td>Placement supports the level of contact to the parents that is deemed appropriate:</td>
<td>☒ Yes  ☐ No</td>
</tr>
<tr>
<td>Placement is the least restrictive, most family like setting consistent with child's best interest and special needs:</td>
<td>☒ Yes  ☐ No</td>
</tr>
</tbody>
</table>

Supporting information regarding above statements: Christina was placed in Hillsborough County with her father. There was a change of custody in December and Christina now lives with her paternal aunt. The paternal aunt, Kathleen FN5, and the father, James FN3, live in the same neighborhood; so Christina has gone to the same school since arriving in Hillsborough County. Christina has constant communication with her mother and brother and visits them once every 2 months.
## Residential Group Care

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the child 11 years or older</td>
<td>☒</td>
<td>☐</td>
</tr>
<tr>
<td>Has the child been in licensed family foster care for 6 months or longer?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>Has the child been moved more than once while in licensed family foster care?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>Does the child meet criteria for extraordinary needs as described in s.409.1676 (2)(a), Florida Statutes?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>If yes to the four questions above, has the child been assessed for placement in licensed residential group care?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>If the child has not been assessed for placement in licensed residential group care explain why not.</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>Did the assessment recommend residential group care?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>If the assessment recommended residential group care, is the child in residential group care?</td>
<td>☐</td>
<td>☒</td>
</tr>
<tr>
<td>If the assessment recommended residential group care, and the child is not in residential group care explain why not.</td>
<td>☐</td>
<td>☒</td>
</tr>
</tbody>
</table>

## Permanency considerations at 12 months (or 12 of 22 months)

- ☒ Child is placed with a fit and willing relative
  
  Supporting Information: Christina was placed with her paternal aunt, Kathleen FN5, in December and the placement is stable. All parties agree that it is in Christina’s best interest to remain with her aunt and permanent guardianship be granted.

- ☐ Termination of parental rights/adoption is not in the best interest of the child
  
  Supporting Information:

- ☒ Reasonable efforts to safely reunify the child have not been made.
  
  Supporting Information:

- ☒ Grounds for involuntary TPR do not exist
  
  Supporting Information:

- ☒ Reasonable efforts to prevent removal or reunify the family or achieve the permanency goal
  
  Supporting Information: Angela FN1 agreed to keep the paramour, John FN2, out of the home and to participate with Non-Judicial In-Home Services; however, after her drug evaluation she relapsed and left her children in the grandmother’s care, failing to return for one week. Angela is currently working on her case plan and she wants to be reunified with Fred. She has agreed to the Case Manager’s recommendation of Christina’s goal change to permanent guardianship with the paternal aunt.
<table>
<thead>
<tr>
<th>Rilya Wilson Act Compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the child between the ages of 3 to 6 years and under the supervision of the Department?</td>
</tr>
<tr>
<td>Yes ☒ No</td>
</tr>
</tbody>
</table>

| Has the child been attending the daycare facility for the required 5 days a week or as otherwise ordered by the Court? |
| ☐ Yes ☐ No | |

| If not attending as required explain the number and reasons for excused and unexcused absences. |
| | |

| If there were any lapses in the child’s daycare attendance did the day care provide proper notification to the Department or contract provider? |
| ☐ Yes ☐ No | |

| If there were two consecutive unexcused absences or seven consecutive excused absences reported was the required follow-up visit to the child’s residence completed? |
| ☐ Yes ☐ No | |

Outcome of the visit or explanation why visits were not made:

<table>
<thead>
<tr>
<th>Independent Living Services (Applies only to children in licensed care ages 13-17)</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Child is not yet 13 years of age or is not in licensed foster care.</td>
</tr>
</tbody>
</table>

| ☐ Child is 13+ years of age and has been referred for Independent Living. |
| Date Referred: | |

For a youth who has reached 13 years of age but is not yet 18 years of age, the adequacy of the youth’s preparation for adulthood and living independently:

| ☒ Independent Living Assessment was completed: |
| Date Completed: | |

Results of the Independent Living assessment, and any specific needs or services needed and the status of the delivery of services:

| ☐ Independent Living staffing completed: |
| Date Completed: | |

Information discussed at required staffing, including services provided and youth’s progress toward developing Independent Living skills:
Education and Career Path

- Attending a 4 year college, or university or community college plus university or a military academy
- Receiving a two year post secondary degree
- Attaining a post secondary career or technical certificate
- Beginning immediate employment, including apprenticeship after completion of a high school diploma or its equivalent or enlisting in the military

Youth's progress and any obstacles the youth is facing in achieving their educational and career path:

An updated case plan has been provided to the court that includes specific information related to independent living services that have been provided since the youth's 13th birthday, or since the date the child came into foster care. □ Yes □ No

Is child 17 years of age or older? □ Yes □ No

If so child has been provided with the following:
- A current Medicaid card
- A certified copy of his or her birth certificate
- A valid driver's license or Florida identification card
- Information relating to Social Security Insurance benefits, if the child is eligible for such benefits
- A full accounting of Social Security Insurance benefits and information on how to access those funds, if the child has received these benefits and they are being held in a trust
- Information and training related to budgeting skills, interviewing skills, and parenting skills
- All relevant information related to the Road-to-Independence Program, including, but not limited to, eligibility requirements and forms necessary to apply
- Has an open bank account or identification necessary to open such an account, and has been provided with necessary banking skills
- Information on public assistance and how to apply
- A clear understanding of where he or she will be living on his or her 18th birthday, how living expenses will be paid and what educational program or school he or she will be enrolled in
- Notice of the right to petition for the court's continuing jurisdiction for 1 year after the youth's 18th birthday and with information on how to obtain access to the court
- Has been encouraged to attend all judicial review hearings occurring after his or her 17th birthday

If this is the Judicial Review hearing that is being held within the month that begins the 6 month period before the youth's 18th birthday, when placed in licensed foster care, has a plan to outline the youth's transition to adulthood been submitted to the court? □ Yes □ No
### Participation

<table>
<thead>
<tr>
<th>Was child notified of hearing?</th>
<th>☒ Yes</th>
<th>☐ No</th>
</tr>
</thead>
</table>

Describe child’s plan for participation at hearing: Christina will be present at the hearing. She will travel from Tampa with her paternal aunt and father.

If child is not attending state reason:

Compliance with court orders:

Child: FN1, Christina

The paternal aunt, Kathleen FN5, has complied with all necessary court orders and has been supportive of the permanency plan for Christina. Christina is doing well with her aunt and it is in her best interest to remain in her care permanently. All parties are in agreement with the permanency plan. Christina remains well bonded with her mother and brother and visits them every 2 months. She has family dinner with her father, stepmother, stepbrother, aunt and cousin every Sunday at the paternal aunt’s house.

Caregiver:
The caregivers have complied with court orders and agree with the permanency plan for Christina.

### Reasonable Efforts

Need for services and efforts to obtain services to meet the special needs of the child: N/A

Reasonable efforts of the agency to finalize the permanency plan currently in effect: All appropriate referrals were made for services for the mother and father on 09/08/2008. Angela’s progress has been closely monitored. Referrals for therapy were made for Christina. The foster mother agreed to supervise visits between Fred and Angela. Angela obtained stable employment in January. The duration and number of visits has greatly increased. The mother contacts the Case Manager on a weekly basis to update her progress.
### IX. Health Information

<table>
<thead>
<tr>
<th>Name of Primary Physician:</th>
<th>Dr. David Jones; Jefferson Pediatric Clinic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address of Physician:</td>
<td>1003 Southside Blvd. Jacksonville, FL 32299</td>
</tr>
<tr>
<td>Other Healthcare Provider:</td>
<td></td>
</tr>
<tr>
<td>Address of Other Healthcare Provider:</td>
<td></td>
</tr>
<tr>
<td>Name of Dental Provider:</td>
<td></td>
</tr>
<tr>
<td>Address of Dental Provider:</td>
<td></td>
</tr>
<tr>
<td>Name of Mental Health Professional:</td>
<td></td>
</tr>
<tr>
<td>Name of Psychiatrist:</td>
<td></td>
</tr>
<tr>
<td>Date of last Comprehensive Behavioral Health Assessment:</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Primary Physician:</th>
<th>Dr. Earl Richards; Carrollwood Pediatric Clinic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address of Physician:</td>
<td>1003 Dale Mabry. Tampa, FL 32624</td>
</tr>
<tr>
<td>Other Healthcare Provider:</td>
<td></td>
</tr>
<tr>
<td>Address of Other Healthcare Provider:</td>
<td></td>
</tr>
<tr>
<td>Name of Dental Provider:</td>
<td>Dr. Patrick Evans</td>
</tr>
<tr>
<td>Address of Dental Provider:</td>
<td>14167 Anderson Road, Tampa, FL 33625</td>
</tr>
<tr>
<td>Name of Mental Health Professional:</td>
<td></td>
</tr>
<tr>
<td>Name of Psychiatrist:</td>
<td></td>
</tr>
<tr>
<td>Date of last Comprehensive Behavioral Health Assessment:</td>
<td></td>
</tr>
</tbody>
</table>
Medications:

<table>
<thead>
<tr>
<th>Physician/Practitioner</th>
<th>Prescribed Medication</th>
<th>Is Medication Psychotropic</th>
</tr>
</thead>
</table>

Date Prescribed:  
Date Stopped:  

Diagnosis, assessments and/or treatments for the child:

| Child DOB:  
First Service Date:  
Last Service Date:  
Other Provider:  
Condition Type:  
Provider Type:  
Type of Service:  
Procedure:  
Diagnosis:  

Description of diagnosis, assessment and/or treatment for the child:

X. Current Education Information

| Christina FN1  
Child’s DOB: 04/26/1998  
Current School Name: Carrollwood Elementary  
Current Grade Level: 4  
Date of child’s current Individualized Education Plan (if applicable):  
Current Program Type:  
Current School Address: 145 Hershey Drive  
Tampa, FL 33624  

Chronology of school placements and reason for the change in school setting:

| Child’s DOB:  
Start Date:  
School District:  
School Name:  
Reason for Change:  
Program Type:  
School Address:  


## Attachments to the Judicial Review

### Medical / Mental Health
- Medical records
- Mental health records
- Immunization records
- Dental records

### Visitation Plan(s)
- Include parents, siblings & grandparents (if applicable)

### Education
- Report cards
- Individual Educational Plan (if applicable)
- Other school records

### Master Trust
- Quarterly Accounting Statement

### Other
- Rights and Responsibilities
- Out of Home Plan (if child in removal episode)

---

Explanation if any attachments are missing: All applicable documents are attached. None of the children qualify for a Master Trust Account. Christina does not have an IEP.
Module 5: Medical/Mental Health Documentation
Create a Medical/Mental Health Profile & History

Create a Medical/Mental Health Profile & History

- From the Desktop, Select Create Case Work menu option OR
  - Click the Case Work banner button to display the Create Case Work page

- From the Medical/Mental Health dropdown field
  - Select Medical Profile
  - Select FN1, Angela (AD) Case from the Cases group box
  - Select FN1, Fred (AD) from Case Participants group box

- Update Fred's Medical Profile in the Primary Health Care Providers group box
  - Enter: Fred’s Doctor: Dr. David Jones
  - Emergency contact 904-123-4567

- In the Basic group box
  - Enter: Group in the specific health problems field
  - None in the allergies field
  - Check the box indicating immunizations are up to date and enter 09/03/2008

To Add Medications

- Select the Medications Tab
  - In the Summary of Medications box, click Insert
    - Enter: Dr. David Jones in the prescribing physician field

- Select Other in the Name of Prescribed Medication dropdown field
  - Enter: Amox-Clav in the text field
  - Enter: 02/25/2009 for date prescription was prescribed
  - Enter: ½ teaspoon twice a day in Dosage text box
  - Enter: Group for Reason for Medication

- Click Save and Close
  - On Medical/Mental Health Screen
    - Select: Mental Health Profile tab

- Complete Treatment Information group box fields
  - Click Axis 1 expando to display group box
    - Select: choice from dropdown

- Click Axis 2 expando to display group box
  - Select: choice from dropdown

- Select appropriate information in Caregiver(s) Information at time of Intake dropdown boxes
  - Click Save
Medical History Tab

From the Medical/Mental Health page
- Select Medical History tab

Click the Insert button
- Displays the Treatment History group box

From the Condition Type drop down box
- Select: Medical
- Enter: Dr. Jones in the other Provider text field

From the Provider Type drop down box
- Select: Pediatrics
- Enter: Routine blood work in the Procedure text field

Click Save

To View or Update Medical/Mental Health Record

From Desktop Outliner
- Open Cases expando

Click the FN1, Angela (AD) Case folder icon
- Drill down by clicking on Medical/Mental Health icon

Select the hyperlink for FN1, Fred (AD)
- If an update is necessary, all appropriate fields on each tab must be updated.
Module 6: Parental Reunification

Parental Reunification Readiness Assessment and Home Study

From the Desktop

Select Create Case Work menu option OR click the Case Work banner button to display the Create Case Work page

From the Planning dropdown box

Select: Reunification Home study
Select: FN1, Angela (AD) Case Name from Cases group box
Case participants are grayed out as Study is completed at family level;
Select: Create

From General Information group box

Select: Reunification Home Study from Options dropdown box

Click Go

Complete Parental Reunification Readiness Assessment and Home Study as it relates to the reunification of FN1, Fred (AD) and FN1, Angela (AD)

Click Close and Return to FSFN

Click Save

Return to the Desktop and the Reunification Home study is located in the Planning expando.
# PARENTAL REUNIFICATION READINESS ASSESSMENT AND HOMESTUDY

**Date Assessment/Homestudy Completed:**
Today’s Date will Auto populate

**Caseworker Name:**
Trainee Name

**Date(s) of Removal(s):**
09/03/2008

**Reasons for Agency Involvement (List All):**
Inadequate supervision; Substance Misuse.

**Names of Child(ren) to be Reunified and Ages:**
FN1, Fred 6 months old

**Dates of all Home visits to Parent’s/Reunification Home:**

**Date Child(ren) Began Unsupervised Visits with this Parent:**
12/12/2008

**Date Child(ren) Began Overnight Visits with this Parent:**
1/12/2009

## REUNIFICATION PARENT AND HOUSEHOLD DEMOGRAPHIC INFORMATION

<table>
<thead>
<tr>
<th>Full Legal Name</th>
<th>Relationship to child being Reunified</th>
<th>Date of Birth</th>
<th>Place of Birth City &amp; State</th>
<th>Social Security Number</th>
<th>Marital Status (circle one)</th>
<th>Have required Record Checks been done? (circle one)</th>
<th>Does this person have a Juvenile or Criminal Record? (circle one)</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1 Name: FN1, Angela</td>
<td>Mother</td>
<td>7/15/1981</td>
<td>Jacksonville, Florida</td>
<td>985668456</td>
<td>S M D</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>#2 Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>S M D</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Information on all other child and adult reunion household members, including anyone who frequently visits the home, or frequently is or will be in the home (whether or not in a potential caretaking capacity); attach an additional sheet if necessary.

<table>
<thead>
<tr>
<th>Full Legal Name</th>
<th>Relationship to Child being Reunified</th>
<th>Date of Birth</th>
<th>Place of Birth City &amp; State</th>
<th>Social Security Number</th>
<th>Marital Status (circle one)</th>
<th>Have required Record Checks been done? (circle one)</th>
<th>Does this person have a Juvenile or Criminal Record? (circle one)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FN1, Shirley</td>
<td>Maternal Grandmother</td>
<td>3/20/1959</td>
<td>Jacksonville, Florida</td>
<td>124656589</td>
<td>S M D</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>S M D</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>S M D</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
## Information on all minor and adult children of the reunification home parent(s), who do not live in the home.

<table>
<thead>
<tr>
<th>Full Legal Name</th>
<th>Relationship to Parent or Caregiver</th>
<th>Date of Birth</th>
<th>Current Address</th>
<th>Telephone Number</th>
<th>Marital Status (circle one)</th>
<th>Have required Record Checks been Done? (circle one)</th>
<th>Does this person have a Juvenile or Criminal Record? (circle one)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Christina FN1:</td>
<td>daughter</td>
<td>4/26/1998</td>
<td>Jacksonville, Florida</td>
<td>11296255</td>
<td>$ M D</td>
<td>Yes No</td>
<td>Yes No</td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Results of all record checks (use this space to provide information on all results; attach additional sheets if necessary)**

Include date of most recent checks and explain results of any juvenile, local, county, state (FCIC) and National (NCIC) record checks. Note that DJJ checks must be completed on all household members age 12 and over; NCIC checks do not need to be done on a parent, but must be completed on any person age 18 and over in the home. *Include all police call-outs/calls to service.*

Local background checks and FCIC checks were completed as well as abuse/registry checks on Angela and Shirley FN1 on 8/28/2008 No records found
<table>
<thead>
<tr>
<th>Name</th>
<th>Allegations</th>
<th>Date of Report</th>
<th>Initial and Final Roles in Investigation</th>
<th>Disposition</th>
<th>Date of Report</th>
<th>Initial and Final Roles in Investigation</th>
<th>Disposition</th>
<th>Allegations</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Pursuant to 39.321(2)(2), a records check through the Florida Abuse Hotline Information System on all household members, and any other persons made known to the Department, who are frequent visitors in the home, has been conducted. Pursuant to 39.321(2)(2), there is no information that can be disclosed.

Use this space to document results of all FAHIS abuse reports involving any household member, and every other person known to be a frequent visitor in the home. You do not need to replicate the report initiated by the Department or the removal of the child(ren). Those reports must be listed here, as well as any reports on other household members or frequent visitors (use additional sheets if necessary).
### ASSESSMENT OF THE REUNIFICATION HOME AND PHYSICAL ENVIRONMENT

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Reunification Home Address:</td>
<td>1321 Sunset Blvd McClenny, Florida 32209</td>
</tr>
<tr>
<td>2. Term of Lease (if applicable):</td>
<td></td>
</tr>
<tr>
<td>3. How Long at Current Address?</td>
<td></td>
</tr>
<tr>
<td>Caregiver #1:</td>
<td>8 months</td>
</tr>
<tr>
<td>Caregiver #2:</td>
<td></td>
</tr>
<tr>
<td>4. Rent or Own? (circle one)</td>
<td></td>
</tr>
<tr>
<td>Owner name:</td>
<td></td>
</tr>
<tr>
<td>Landlord name:</td>
<td></td>
</tr>
<tr>
<td>Landlord phone:</td>
<td></td>
</tr>
<tr>
<td>5. Home phone:</td>
<td>904 578 9907</td>
</tr>
<tr>
<td>Caregiver #1 cell:</td>
<td></td>
</tr>
<tr>
<td>Caregiver #2 cell:</td>
<td></td>
</tr>
<tr>
<td>6. Does the parent have a valid driver’s license or State of Florida identification?</td>
<td></td>
</tr>
<tr>
<td>Parent #1:</td>
<td>Yes [X] No [ ]</td>
</tr>
<tr>
<td>Parent Number: H120-157-80-548-0</td>
<td></td>
</tr>
<tr>
<td>Parent #2:</td>
<td>Yes [X] No [ ]</td>
</tr>
<tr>
<td>Parent Number:</td>
<td></td>
</tr>
<tr>
<td>7a. Previous Address (last 3 years): Parent/Caregiver #1:</td>
<td>1317 Maple Street McClenny Florida 32209</td>
</tr>
<tr>
<td>7b. Previous Address (last 3 years): Parent/Caregiver #2:</td>
<td></td>
</tr>
<tr>
<td>8. General Description of Reunification Home (including number of rooms and number of bedrooms): Angela FN1’s home has seven rooms which include three bedrooms, one bathroom, a kitchen, a dining room and a den. The home is clean and free of hazards.</td>
<td></td>
</tr>
<tr>
<td>9. General Description of Neighborhood: Angela FN1’s home is located in a clean safe neighborhood. There are many families and children residing in the neighborhood.</td>
<td></td>
</tr>
<tr>
<td>10. Date Sex Offender Neighborhood Check (1 mile radius of home) was completed, and results:</td>
<td></td>
</tr>
<tr>
<td>02/27/09 No sex offenders were located within a 1 mile radius of the home.</td>
<td></td>
</tr>
<tr>
<td>11. Name of School(s) the Child(ren) will Attend:</td>
<td>ABC Daycare; Fred will attend Monday-Friday 8:30am till 5:30pm</td>
</tr>
<tr>
<td>12. Method of Child’s Transportation to School (walk, bus, bike, car; indicate who will drive child):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angela FN1 (Mother)</td>
</tr>
<tr>
<td>13. The reunification home is adequately furnished</td>
<td>Yes [X] No [ ]</td>
</tr>
<tr>
<td></td>
<td>Fred has a crib in his room, that will convert into a toddler bed. Christina’s room is also furnished for when she comes to visit.</td>
</tr>
<tr>
<td>14. Will provide each child with adequate and appropriate sleeping arrangements (every child in own bed/crib; no child in bed w/ adult)</td>
<td>Yes [X] No [ ]</td>
</tr>
<tr>
<td></td>
<td>Fred and Christina have their own rooms with all appropriate bedding and sleeping facilities.</td>
</tr>
<tr>
<td>15. Has no visible hazardous conditions, including level of cleanliness, which would be hazardous to child health and safety</td>
<td>Yes [X] No [ ]</td>
</tr>
<tr>
<td></td>
<td>There are no visible hazardous conditions in the home.</td>
</tr>
<tr>
<td>Question</td>
<td>Option</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>16. has a pool or is near water, and the parent has been counseled on water safety, or safety measures are or will be in place upon reunification</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>17. has reasonable security measures</td>
<td>Yes</td>
</tr>
<tr>
<td>18. has medicines, alcohol, cleaning agents out of reach of children</td>
<td>Yes</td>
</tr>
<tr>
<td>19. has guns/amunition in locked cabinet</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>20. has working smoke/fire alarm</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## DETERMINATION OF PARENTAL FINANCIAL SECURITY, RESOURCES, AND CHILDCARE ARRANGEMENTS

<table>
<thead>
<tr>
<th></th>
<th>Parent/Caregiver #1:</th>
<th>Parent/Caregiver #2:</th>
<th>Household:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1. Current Employer Name</strong></td>
<td>Angela FN1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verified? YES NO N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| **2. Employer’s Address** | 1145 Blanding Road   |                      |            |
| Merck Association         | Jacksonville, Fl     |                      |            |

| **3. Length of Current Employment** | 2 months |                      |            |
| **4. Hours and Shifts Worked**    | 9 am–5 pm M–F |                      |            |

| **5. Gross Salary** | $ 400.00 week |                      |            |
| weekly/biweekly/monthly (circle one) | weekly/biweekly/monthly (circle one) |                      |            |

| **6. Medicaid Eligible?** | Yes No Unknown (circle one) | Yes No Unknown (circle one) |                      |
| **7. Additional Support or Income** |                      | Child Care | $200 |
| Social Security Benefits | $ | $ | Other Bills (please list) |
| Retirement Benefits | $ | $ | Car insurance | $100.00 |
| WAGES (Temporary Case) | $ | $ | $ |
| Disability Benefits | $ | $ | $ |
| Other (Shirley FN1) | $ | $ | $ |

| **Total** | $ | $ | Total Monthly Expenses = $980.00 |
## CONCLUSIONS (attach additional sheets if necessary)

<table>
<thead>
<tr>
<th>10. Does the family have sufficient funds to support their current expenses? <strong>X Yes</strong>. <strong>No</strong> if “No,” explain how they will manage once reunified:</th>
</tr>
</thead>
</table>
| 11. Will childcare be needed? **X Yes**. **No** if “Yes,” how and by whom will it be provided and funded?  
Angela FN1 will pay for Fred’s daycare. |
| 12. Will after school care be needed? **“Yes X No**. if “Yes,” how and by whom will it be provided and funded? |
| 13. What new expenses are anticipated once the child(ren) are reunified? List known and estimated projected costs:  
Diapers, formula, clothing, everyday life supplies, hygiene, etc... |
| 14. Will the family be able to provide sufficient care for the reunified child(ren) without causing financial hardship for the family?  
**X Yes**. **No** if “No,” provide a detailed explanation of type, amount and duration of assistance to be provided to the family:  
With the support from her mother (Shirley FN1), Angela FN1 will be able to support her son, Fred, without causing financial hardship. Angela also receives great support from Christina’s father, James FN3, in Tampa Florida. Christina will remain in Tampa. |
| 15. Do any family members or does the caseworker have any concerns regarding the family’s ability to financially provide for this child upon reunification? **“Yes X No**. if “Yes,” provide a detailed explanation of concerns:  
With support from her mother, and Christina’s family in Tampa, there are no concerns regarding Angela’s ability to financially provide for the children. |
<table>
<thead>
<tr>
<th>Task/Issue</th>
<th>Provider Information</th>
<th>Date Completed</th>
<th>On-Going Services / UAs / Safety Plan / Comments</th>
</tr>
</thead>
</table>
| Parenting             | Substantial Compliance
1 x week for 8 weeks parenting | 01/16/2009     | Angela FN1 has been observed by the Case Manager utilizing the parenting techniques learned in class. Case Manager will continue to monitor Angela FN1's parenting techniques during monthly PPS visits in the home. |
| Substance Abuse       | Substantial Compliance
Out-patient services
3 x week for 16 weeks | 12/8/2008     | Angela FN1 completed 8 weeks of Outpatient Substance Abuse treatment                                               |
| Services for Child(ren) | Substantial Compliance
Daycare for Fred; | 9/3/2008      | Fred will attend daycare everyday. It is the same day care he has always gone too.                                 |
| Stable employment     | Substantial Compliance                | 12/5/2008     | Angela got a job a receptionist working Monday through Friday 9-5. She is making good money to provide for herself and her children. |
| Other (Specify)       |                                       |                |                                                                                                                  |
# PARENTAL CASE PLAN SUMMARY AND COMPLIANCE

<table>
<thead>
<tr>
<th>NAME:</th>
<th>PARENT (# 2)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Task/Issue</th>
<th>Provider Information</th>
<th>Date Completed</th>
<th>On-Going Services / UAs / Safety Plan / Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parenting</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Substance Abuse</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Domestic Violence</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mental Health Treatment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Anger Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counseling: Individual or Family</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Services for Child(ren)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other (Specify)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The parent(s)...</td>
<td>#1 Name: FN1, Angela</td>
<td>#2 Name:</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>1. demonstrates a strong desire to care for child(ren); explain how (e.g., attends hearings, all visits, etc.)</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has maintained excellent contact with her children; she has attended all hearings and has been fully cooperative with the CBC in order to be reunified with her children.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>2. demonstrates an understanding of the reason(s) for removal of child(ren); explain how</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela admitted needing help with her drug problem and realized it impaired her ability to care for her children.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>3. demonstrates an understanding of child-specific care needs</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has shown an understanding of age appropriate child specific care needs.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4. has family and/or other sources of support</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Shirley FN1 (Angela’s mother) supports Angela and the children whenever needed.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>5. demonstrates a willingness to follow through with referrals and services; explain how</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has been compliant in following up with all referrals made for services.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>6. demonstrates an ability to ask for and accept help when needed; explain how</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has asked for help with her substance abuse problem and has followed through with the services provided.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>7. appears to be in good health and reports no serious medical conditions that would be a hindrance in caring for child(ren)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes  No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angela is in good health however admitted to needing outpatient drug treatment which was successfully completed.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. states that s/he is free of substance or chemical dependency, explain any substance abuse history, including treatment received (explanation not needed for parent, if already known)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes  No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angela received Outpatient substance abuse treatment and she has been clean and sober for almost 3 months.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. has a history of mental illness and/or mental illness in the family, explain any mental health history, including treatment received (explanation not needed for parent if already known)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes  No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No history that is known.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. has a history of domestic violence; explain any domestic violence history, including treatment received (explanation not needed for parent if already known)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes  No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>#1 Name: FN1, Angela</td>
<td>#2 Name:</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---------------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>11. demonstrates an understanding of the child's need for stability and permanence (explain how)</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angela realizes that her children need to feel safe and secure and to grow up in a healthy stable environment. She has seen her children regularly and has kept in close contact with her mother, which is an excellent support system for her.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. shows willingness to participate in case plan and attend court hearings until PPS and court jurisdiction terminated</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angela has attended every hearing since the children have been removed from the home. She has completed all the tasks on her case plan and her behavior (Substance Abuse) has been eliminated due to her completion of outpatient treatment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. is committed to following through with any court restrictions on parental or relative visitation; identify any visitation restrictions</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angela complied with her supervised visits with her children, progressed to unsupervised, then to overnight visits. She is committed to keep John FN2 away from Fred unless it is supervised by an appropriate contracted employee.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. is committed to support sibling visitation, if applicable; describe how sibling visits will be arranged</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NA</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Angela and Fred will visit Christina at least monthly due to her placement in Tampa Florida.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Question</td>
<td>Yes</td>
<td>No</td>
<td>NA</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>15. has ensured that any pets are well-cared for and do not present safety concerns; are pet shots up to date?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>There are no pets involved.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16. will ensure that the child(ren) will continue to attend school on a regular basis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angela will drive Fred to and from daycare.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17. will ensure that the child(ren) attend daycare on a daily basis and will comply with the Rilya Wilson Act (if applicable); specify name of daycare</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela is aware of the Rilya Wilson Act and will ensure that Fred attends daycare Mon-Fri.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18. can describe and demonstrate appropriate methods of discipline that are age-appropriate for the child(ren) who are to be reunified; how?</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has been observed during parent/child visitations demonstrating age appropriate discipline methods, i.e., time out, reward system.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19. is able to arrange/provide transportation for child(ren) to all necessary appointments including medical and dental appointments, counseling sessions, school, visitations, and court hearings.</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Angela has a car and can provide transportation for her children to all appointments.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20. has car seats (as required by law) to transport each child safely</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fred has a car seat in the car.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Module 6: Parental Reunification

---

## INFORMATION ABOUT THE CHILD(REN), THE PARENTS/PRIMARY CAREGIVERS, AND THE REUNIFICATION HOUSEHOLD

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>21. Will the person responsible for the maltreatment which resulted in the child's out-of-home placement be the primary caregiver of the child(ren) being reunified?</td>
<td>Yes</td>
<td>No</td>
<td>Angela left the children home alone while out late night partying. The maltreatment was inadequate supervision and substance misuse; Angela, who is the primary caregiver, will be reunited with child Fred.</td>
</tr>
<tr>
<td>22. Since case initiation, has the parent demonstrated an ability to safely and appropriately handle stress or crisis?</td>
<td>Yes</td>
<td>No</td>
<td>Angela has learned better problem solving skills and stress reducers to deal with stresses and problems that can arise in everyday life situations through her individual therapy sessions and through her substance abuse treatment. She remains calm and stays focused on the task at hand.</td>
</tr>
<tr>
<td>23. Have there been any changes in the parent's status or living arrangements since the initiation of the case?</td>
<td>Yes</td>
<td>No</td>
<td>No changes.</td>
</tr>
<tr>
<td>24. Do any of the following factors affect any members of the reunification household at the present time?</td>
<td>Yes</td>
<td>No</td>
<td>Please identify and explain how these issues are being dealt with (i.e., what services are currently in place or need to be in place to address and help minimize the potentially negative impact of these stress factors?) No factors are known that will affect the members of the reunification household.</td>
</tr>
</tbody>
</table>

Unemployment; disability/chronic illness; recent divorce/separation or marriage; pregnancy or new children (other than ones being reunified); new parental relationship(s); domestic violence; substance abuse; financial problems; housing concerns; mental health issues; death of a close friend or family member; pending law violations or incarceration.
<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>25. Do any children to be reunified (or already in the home) have specific medical, emotional, psychological, behavioral or educational needs?</td>
<td>Yes</td>
<td>No</td>
<td>Fred is 6 months and is a healthy child.</td>
</tr>
<tr>
<td>26. Has the parent demonstrated an increased understanding of each child's needs (including the target child, if applicable)?</td>
<td>Yes</td>
<td>No</td>
<td>Angela realizes that in the past she has placed a lot of responsibility on Christina to watch and care for her younger brother, Fred. However, through parenting classes and individual therapy she has focused on having better problem solving skills and knows now to always ask her mother for help with Fred if she needs it.</td>
</tr>
<tr>
<td>27a. How will the parent meet the needs and cope with the challenges of child Fred</td>
<td>Yes</td>
<td>No</td>
<td>Angela will ensure Fred attends daycare Mon-Fri. and that he is provided with food, clothing, and shelter.</td>
</tr>
<tr>
<td>27b. How will the parent meet the needs and cope with the challenges of child #2 (if applicable)</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>27c. How will the parent meet the needs and cope with the challenges of child #3? (if applicable)</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Question</td>
<td>Yes</td>
<td>No</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----</td>
<td>----</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>28. Has anyone (including any of the children) expressed any concerns regarding the alleged perpetrator's access to the child(ren) once reunified?</td>
<td>Yes</td>
<td>No</td>
<td>Fred is 6 months old and non verbal. Christina is living with her aunt, Kathleen, in Tampa Florida.</td>
</tr>
<tr>
<td>29. Has anyone (including any of the children) expressed any concerns regarding the alleged perpetrator continuing to pose a threat to any of the children?</td>
<td>Yes</td>
<td>No</td>
<td>The maternal grandmother, Shirley FN1, has a very strong bond with her daughter and will help her daughter in any way she can so that John FN2 does not come back into Angela's or Fred's life.</td>
</tr>
<tr>
<td>30. Have any of the children expressed fear of or discomfort around any person who will be in or frequenting the home upon reunification?</td>
<td>Yes</td>
<td>No</td>
<td>No concerns expressed</td>
</tr>
<tr>
<td>31. If there is a GAL assigned to the case, is the GAL in favor of reunification occurring at this time?</td>
<td>Yes</td>
<td>No</td>
<td>Unk</td>
</tr>
<tr>
<td>32. Is there a safety plan needed or already in place for this reunification? If so, what is the plan?</td>
<td>Yes</td>
<td>No</td>
<td>There is a safety plan in place for the child Fred and the mother at this time. Upon John FN2's release from jail, Angela will contact the Case Manager if John tries to have any unsupervised contact with Fred.</td>
</tr>
<tr>
<td>33. Has the parent or person who will be the primary caregiver shown progress in stable, independent functioning?</td>
<td>Yes</td>
<td>No</td>
<td>Angela got a job as a receptionist and is able to provide for herself and her children. She completed all case plan tasks. She has shown significant progress in her decision-making skills and ability to function in everyday life.</td>
</tr>
<tr>
<td>Question</td>
<td>Yes/No</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>34. Are there any challenges or barriers to the parent achieving stable, independent functioning? If so, what are they, and what services can be provided in order to overcome the barriers?</td>
<td>Yes/No</td>
<td>Angela has completed all of her case plan tasks and has been determined and dedicated to be reunified with her son. She has a great job now and can provide for herself and her children. The only challenge for Angela could be when or if John FN2 is released from jail and tries to come back to her.</td>
<td></td>
</tr>
<tr>
<td>35. Has the parent or person who will be the primary caregiver shown progress in utilizing parenting skills that promote child safety and well-being?</td>
<td>Yes/No</td>
<td>Angela has shown significant progress in her parenting skills as observed through interaction with her children during parent/child visits. She has learned age appropriate activities for the children as well as age appropriate discipline strategies i.e., time out, reward system, etc...</td>
<td></td>
</tr>
<tr>
<td>36. Are there any challenges or barriers to the parent utilizing parenting skills that promote child safety and well-being? If so, what are they, and what services can be provided in order to overcome the barriers?</td>
<td>Yes/No</td>
<td>No challenges noted.</td>
<td></td>
</tr>
<tr>
<td>37. What does the parent see as his/her biggest strength in making this a successful reunification?</td>
<td></td>
<td>Achieving the goal of completing drug treatment and obtaining a stable job.</td>
<td></td>
</tr>
<tr>
<td>38. What does the parent see as his/her biggest challenge in making this a successful reunification?</td>
<td></td>
<td>Preventing John FN2 from finding her and Fred and trying to come back into their lives.</td>
<td></td>
</tr>
<tr>
<td>39. What does the parent see as his/her biggest need in making this a successful reunification?</td>
<td></td>
<td>To stay away from John FN2 and continue dedicated to improving the lives of her children.</td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Response</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40. What does the case manager see as the parent’s biggest strength in making this a successful reunification?</td>
<td>Angela’s love for her children and her commitment to improving their lives.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41. What does the case manager see as the family’s biggest need in making this a successful reunification?</td>
<td>The need for Angela to have a strong dependable safety plan in place if or when John FN2 is released from jail. Angela must be committed to never letting John back into her life.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42. What services have been put in place to assist with this reunification?</td>
<td>Substance abuse evaluation/ treatment, psychosocial, individual counseling, Parenting classes, support group, daycare referral, supervised visitation, unsupervised, then overnight visitation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>43. What services still need to be put in place to assist with this reunification?</td>
<td>Post placement supervision, weekly for the first month, then bi-weekly for the second and third month and then monthly visits to the home every month after that.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>44. Based upon the Sex Offender Neighborhood Check results (1 mile radius of home), what is the parent’s plan for supervision of the child(ren)?</td>
<td>No sex offenders are within one mile from the home.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45. How does the child feel about being reunified?</td>
<td>Fred is 6 months old and non verbal; however, at all visitations, the attachment that between Angela and Fred is evident and very strong. Fred smiles non stop when he is with his mother.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Yes</td>
<td>No</td>
<td>Christina will remain in Tampa with her paternal aunt, Kathleen FN5; Permanent Guardianship</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
<td>----</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>46. Are any other children who were removed from this parent <strong>not</strong> being reunified at this time?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47. If the reunification of other child(ren) is to be delayed or staggered, explain why this child is being reunified first.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48. If other children will reunify later, specify who, why, and the timetable for reunification of other children.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49. Description of parent’s relationship with spouse/partner (whether or not in the home).</td>
<td></td>
<td></td>
<td>Parent # 1: Angela FN1 does not wish to have a relationship with John FN2 (Fred’s father). John is currently in jail for selling cocaine and there is no date of his release.</td>
</tr>
<tr>
<td>50. Description of parent’s relationship with child’s (or children’s) other parent(s), whether or not in the home (if other than person in # 49).</td>
<td></td>
<td></td>
<td>Parent # 1: Angela has a very bonded, loving relationship with her children. It is in Fred’s best interest to be reunified with his mother and it is in Christina’s best interest to remain in Tampa with her aunt, Kathleen.</td>
</tr>
</tbody>
</table>
## REUNIFICATION PLACEMENT DECISION

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
<th>Signature</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is placement recommended by Caseworker?</td>
<td>X</td>
<td></td>
<td>Caseworker Signature:</td>
<td></td>
</tr>
<tr>
<td>Does Supervisor concur with Caseworker?</td>
<td>X</td>
<td></td>
<td>Supervisor Signature:</td>
<td></td>
</tr>
<tr>
<td>Does Program Administrator concur?</td>
<td>X</td>
<td></td>
<td>PA/Designee Signature:</td>
<td></td>
</tr>
<tr>
<td>Is this <strong>Reunification Placement</strong> approved?</td>
<td>X</td>
<td></td>
<td>Approval/Disapproval Signature:</td>
<td></td>
</tr>
</tbody>
</table>

**Comments:**
Module 7: Case Closure

Closing a Case

From the Desktop → Expand FN1, Angela (AD) Case icon

Expand the Placement/Services icon → Select the placement hyperlink for FN1, Fred (AD) that is currently open

Click the Options dropdown box → Select Removal/Placement Ending

Enter End Date and Time: 03/03/2009 10:00am
Select Ending Reason: Discharge from Removal Episode
Selecting Ending Purpose: Reunification with Parent

Click Go → System selects YES

Screen refreshes and automatically populates with “Is the end of this child’s placement a discharge from the removal episode?”

For Discharge Reason → Select: Reunification with Parent/Primary Caregiver

From Options dropdown box → Select Approval

Click Go → Click Approval → Click Continue → Click Save and Close

You must now create a new living arrangement for FN1, Fred (AD)

From the Desktop → Select: Create Casework

Select: Living Arrangement
Select: FN1, Angela (AD) case from Case Name
Select: FN1, Fred (AD) from case participants

Enter Living Arrangement Begin date and time: 03/03/2009 10:01am
Enter End Date and time: 09/03/2009 12:00 pm
Select Living Arrangement: Living with one Parent
Select Primary Caregiver: FN1, Angela (AD)

In the comments narrative box enter:

A JR was held on March 3, 2009 ordering the reunification of Fred with his mother Angela. Post placement supervision to occur for a six month period.

Click Save and Close → Refresh Placement/Services icon to see changes made for FN1, Fred (AD)
Submitting Case for Closure

1. From the **Desktop** select: **FN1, Angela (AD) hyperlink**
2. Maintain **Case information** select: **Closing History tab**
3. From the **Options** dropdown box select: **Submit Case Closure Request**
4. In the **Closing Information** group box select: **Request for Closure**
   - Select Reason: **Court Ordered Supervision Closed**
5. In the **Closure Summary** group box, enter:
   - Case is being closed due to case plan compliance and achievement of reunification and permanent guardianship. Services terminated 09/03/2009.
6. Click **Save**
Module 8: Independent Living

Independent Living Program Referral

From the Menu Bar, click Create on menu bar

Select Case Work from dropdown menu

Select: Independent Living Program Referral
Select: Case Name from Case group box
Select: Child's Name from Case Participants

From Forms dropdown

Click Create

Click on Options dropdown box at bottom of page

Select: Independent Living Program Referral

Date of Form Completion: Auto Populates
Teen's Name: Auto Populates
Teen's DOB and Age: Auto Populates
Teen's Primary Language: Auto Populates

Case Manager Name
Agency
Case Manager's Phone Number
Foster Parent Facility Name: Auto Populates
Foster parent Facility Phone Number: Auto Populates
Teen's Address: Auto populated
Teen's Phone Number: Auto populated
Disability/Mental Health: Auto populated
Enter: Foster Parent Facility Name

Complete Referral Form

The following information must be entered:

Complete Independent Living Requirement Checkbox

4 Yes/No questions

Complete Case Status Questions

Question 1: Auto populates
Question 2: Yes or No
Question 3: Yes or No

Click Close and Return to FSFN

Click Save

Click Close

When the Desktop is refreshed, the Independent Living referral form is in the Forms icon.

Case Manager must sign the form and enter a date of when information was entered into the Independent Living database.
Independent Living Record

From the Desktop page, click Create on menu bar → Select Case Work from dropdown menu → Select: Independent Living Record → Select: Case Name from Case group box → Select: Child's Name from Cases Participants

From Independent Living dropdown → Click Create → Review Independent Living Information group box

On the Academic and Life Skills tab; In the Date of Independent Living Referral group box → Select: Insert → Enter Date: Today's Date or XX/XX/XXXX → Enter referral Type: Initial

In Life Skills group box → Select: Insert → Select Skill: Education Planning → Enter Description text: Need to decide on college → Select Type: Need

In Date Academic and Life Skills Progress group box → Select: Insert → Enter: Today's Date or XX/XX/XXXX → Select Type: Primary/Secondary → Select Education Level: 12th → Select Attendance: Acceptable → Select Performance/Progress: Above → Select Enrolled in College Prep Classes: Yes → Select Status: In Progress

In FCAT group box → Select: Insert → Enter: Date Taken/Waiver Granted XX/XX/XXXX → Select Reading/Math/Science/Writing: Passed → Select Remedial Received: No

Click Save
Module 8: Independent Living

Click second tab Age 13 - 17

Select: Insert for Normalcy Plan Date
Enter Date: XX/XX/XXXX
Enter Type: Initial

Select: Insert
Enter Date: XX/XX/XXXX
Select Type: Initial

Select: Approved – Ready for Placement
(Pose Placement Required)
Enter Date of Plan: XX/XX/XXXX

Select: Insert
Enter Begin and End Dates: XX/XX/XXXX

Click Save

Click third tab Age 18-23
In Road to Independence/
Transitional Support Services

Select: Insert
Enter Date Applied: XX/XX/XXXX
Select Program: Road to Independence
Select Type: Initial
Select Status: Approved
Enter Status Date: XX/XX/XXXX
Enter Date effective/enrolled: XX/XX/XXXX
Enter Needs Assessment Date: XX/XX/XXXX
Enter Authorized Amount: $1000.00

Select: Insert
Enter Date: XX/XX/XXXX
Select Type: Request for Service
Enter Type: Approved
Select Status Date: XX/XX/XXXX

Select: Insert
Enter Date: XX/XX/XXXX
Enter Appeal Reason: Aftercare Support Services Reduction
Select Final Decision Date: Pending

Click Save and Close

The Independent Living Record appears in the Independent Living icon on your Desktop.
Module 9: Interstate Compact for the Placement of Children

Interstate Compact

Creating an ICPC Parent/Relative/Foster Care Checklist from Florida to Another State

From the Desktop ➔ Click Case Name hyperlink ➔ Accesses Maintain Case page

From Options dropdown box ➔ Select: ICPC Parent Checklist

Click Go

Complete ICPC Parent Checklist form for an ICPC placement

Assure that all copies are made in additional to the original

Click Close and Return to FSFN OR Click X at top tight corner of document ➔ Click Save ➔ Click Close ➔ Refresh your Desktop

Creating an ICPC Regulation 7 Checklist from Florida to Another State

Refer to ICPC Parent/Relative/Foster Care Checklist

From Desktop ➔ Click Case Name hyperlink ➔ Accesses Maintain Case page

From Options dropdown box ➔ Select: ICPC Parent Checklist Reg. Checklist

Click Go

Complete the ICPC Regulation 7 Checklist with the appropriate information

Click Close and Return to FSFN OR Click X at top tight corner of document ➔ Click Save ➔ Click Close ➔ Refresh your Desktop

The ICPC checklists are saved in the Maintain Case page in the Options dropdown box.
Creating ICPC Forms

From the Desktop Banner Bar → Click the Case Work Icon

From the Forms dropdown box → Select: ICPC Form 110A or 100B
Select: Case Name
Select: Case Participant/Child’s Name

Click Create → Complete the form
Print the form

Click Close and Return to FSFN → Click Save

Refresh the Case and Expand the Forms icon to view the form

Repeat the steps to create the other ICPC form

The ICPC 100A and 100B forms are located in the Forms icon on the desktop
Self-Led Instruction

Ongoing Assessment and Permanency Scenario: Two FN1, Barbara Family
An intake is received at the hotline on 04/15/2008 at 11:00 a.m. regarding the FN1 Family and alleged that: “The mother, Barbara FN1 and boyfriend, Leroy FN2, left the children home alone unsupervised for a long period of time (3:30 pm to 4:00 am). Barbara FN1 and boyfriend, Leroy FN2, drinks heavily. The children have gone hungry and have been seen wearing the same soiled clothes for three days. Barbara has three children, Gwen, age 8, Jean age 4, and Clyde age 17 months.”

There is one prior on the family. In October, 2005, an intake was received alleging that 22 month old Jean FN1 was found wandering around her apartment complex unsupervised. Barbara FN1 was found intoxicated and passed out in the bedroom. The investigation was closed with verified findings of inadequate supervision and substance misuse (alcohol exposure). Non-judicial In-Home Services were put in place which included outpatient substance abuse counseling, AA classes, and parenting classes. Criminal history received on 04/15/08 for the mother, Barbara FN1, which includes one arrest in 2003 for a DUI charge which was later dropped. Telephone contact was made with the reporter, who verified the allegations in the narrative and stated that this is the third time that they were aware of that the children were left home alone. The man living in the home is named Leroy FN2 and is the father of the oldest child Gwen.

2:45 pm: The intake was assigned to P.I. Denise Newman. She commenced the investigation on 04/15/2008 at 2:45 pm, by responding to the address listed on the intake, 1865 Riverdale Lane, Jacksonville, FL 32209. PI Newman knocked on the door, and Gwen FN2, age 8, answered. Gwen stated that her father was passed out on the couch again, and her mother had not been home since yesterday. With much coaxing, Gwen was able to wake her father.

2:55 pm: PI Newman introduced herself to Leroy FN2. She explained the dependency rights and responsibilities bulletin, and she conducted an initial interview with him. He provided the following demographic data:

Leroy FN2
White/Male
DOB: 01/21/1980
SSN: 878-78-8788

PI Newman explained to Leroy his rights and responsibilities, and gave him a pamphlet. After Leroy FN2 signed the required forms (HIPPA, TANF, ICWA, etc.), the allegations were reviewed with him. There were numerous empty beer cans and three empty beer cases scattered on the living room floor. Leroy had a strong odor of alcohol, and his speech was slurred. He stated the children’s mother, Barbara FN1, and he went out the other night to celebrate their engagement, and he felt that Gwen (8 yr-old) was old enough to watch the other children. He stated that Gwen is his child, but that he didn’t know who fathered the other two children.
Leroy and Barbara broke up when Gwen was 2, and he came back when Gwen was 6. Leroy denied drinking heavily or often, and stated he only drank socially. He indicated that he did not know where Barbara was. They had a fight and he had not seen her since. The refrigerator was observed to have only some condiment containers and beer. No food was observed in the freezer. The pantry was observed to have a can of peaches and 3 cans of vegetables. Leroy also stated that Barbara is responsible for the laundry, and that is why the children had to wear the same clothes for three days.

3:15 pm: PI Newman interviewed Gwen (8-year old) in her room. Gwen shares a room with her sister Jean. PI observed bunk beds with soiled sheets. Soiled clothing was observed covering the floor. There were few toys observed in the room. Gwen stated that she often had to take care of Clyde, age 17 months and Jean age 4 years, because her parents are either passed out from drinking too much, or they often go out all night and don’t come home until the next day. Gwen stated that they were left home alone almost every weekend. She states that she gets afraid when her father drinks, because he will yell at them, and sometimes hit them. She stated that her father hit Clyde yesterday because he was crying, and now Clyde has a black eye. Gwen stated that when her parents left home the other day, the only things in the refrigerator were some hotdogs and juice. Gwen stated that she cooked the hotdogs for her brother and sister, but the food was gone by the morning. Gwen was wearing stained jeans and a t-shirt, and reported her mother has not done the laundry in a couple of weeks.

3:30 pm: PI Newman observed 17 month old child Clyde, in his room. Clyde has a toddler bed, which was observed to have no sheets on it. Clyde’s room also had soiled clothing on the floor and few toys. Clyde spoke but was difficult to understand. PI Newman observed Clyde to have purple bruising around his left eye about one-half inch wide on the temple side of the left eye. When PI asked Clyde what happened Clyde said, “da-da.” Clyde was also wearing stained jeans and a t-shirt.

3:40 pm: PI Newman attempted to interview Jean, age 4. Jean would not sit still, and ran around the house kicking the beer cans on the floor. Jean was dressed in a stained dress and had dirt and food stains on her face.

3:45 pm: PI asked Leroy FN2 about the bruising to Clyde’s eye, and at first he stated that Clyde is very clumsy. He then stated that he really hadn’t noticed the bruising, and does not know how Clyde could have gotten a black eye. PI informed Leroy that Clyde would have to be seen at the Child Protection Team (CPT). Leroy denied any history of childhood abuse. Jacksonville Sheriff’s office (JSO) initiates criminal investigation. PI also requested call outs, arrest records, and address checks. PI Newman contacted her supervisor, and contacted CPT. An appointment was set for 4:30 p.m. Background checks on Leroy FN2 were conducted. He has two arrests. (2000 disorderly Intoxication Conduct, and 2005 domestic violence).
4:00 pm: Jacksonville Sheriff’s Office (JSO) Deputy, D.C. Hendrix began the criminal investigation. Leroy FN2 admitted to hitting Clyde in the face because he would not stop crying. Officer Hendrix told you that he would go with you and the family to the CPT appointment to get their impression.

4:20 pm: PI contacted Children’s Legal Services attorney Robert Hill to staff the case. PI prepared the Legal Staffing form in preparation for staffing:

4:30 pm: Clyde was examined by Dr. Marcus Johnson of the Child Protection Team. Clyde’s injuries were determined to be “diagnostic of abuse.” Clyde was also observed to have linear bruising on his back. Leroy FN2 admitted the bruising was due to him hitting Clyde with a belt. Officer Hendrix read Leroy FN2 his rights and arrested Leroy for Child Abuse and Child Neglect. Leroy advised the PI that the children should stay with their maternal grandmother, Theresa FN1, and her phone number is (904) 555-5789. Leroy stated that to his knowledge the children were not allergic to anything nor, were they taking any medications. PI completed the emergency intake form. Leroy FN2 signed a consent for treatment for Gwen. PI advised Leroy that the children would be removed for physical abuse and neglect and there would be a shelter hearing on 04/16/2008 at 9:30 a.m. in the J1 courtroom at 500 E. Bay Street, Jacksonville, Fl 32202. PI spoke with the children and advised them that they would not be going back home because it was not safe for them to be left alone, and for their parents to be drinking alcohol excessively. The children were reassured that this was not their fault.

5:30 pm: PI telephoned the maternal grandmother, Theresa FN1 and she was willing to care for the children. She provided her demographic information:

Theresa FN1
White/Female
DOB: 05/16/1958
SSN: 867-39-2084
Address: 568 Elm Street, Jacksonville, Fl 32209

PI Denise Newman contacted the Crime Intelligence Unit at the hotline to request a background check on Theresa FN1. Theresa’s background checks were clear.

5:55 pm: PI Newman conducted a home study on Theresa FN1’s home. Theresa FN1 has a 3 bedroom 2 bath home in a quiet neighborhood. She also has beds for all the children and plenty of food in the home. Theresa FN1 needed a referral for daycare but otherwise can meet all the needs of the children. The home study was favorable and the children were placed with Theresa. Theresa FN1 agreed to supervise the visits between the parents and children. You advised Theresa of the shelter hearing on 04/16/2008 at 9:30 a.m. in the J1 courtroom at 500 E Bay Street, Jacksonville, Fl 32202. You took photographs and fingerprints of the children. PI informed Ms. FN1 about the TANF funded TCA Program and the Relative Caregiver Program (RCP). PI provided Theresa FN1 with copies of the emergency intakes along with the Child Resource Records including copies of the Department’s consent for treatment forms and the medical consent forms.
On 04/16/2008, 9:00 am: PI completed the Initial Safety Assessment is completed and the case meets the qualifying criteria for a second party review. The appropriate reviews are completed and the local CBC was contacted to have a Case Transfer/ESI staffing.

On 04/16/2008, 9:30 am: PI attended the shelter hearing and the court finds probable cause for removal from the mother’s home and approved the recommended placement for the children at the maternal grandmother’s home. Supervised visits with the children were approved. Gwen’s father, Leroy FN2, appeared at the shelter hearing as well as his first appearance in the criminal charges. A review of shelter hearing/arraignment was scheduled for 04/28/2008 at 11:00 a.m. Leroy FN2’s bail is set for $25,000.

On 04/16/2008, 2:30 pm: PI completed the FSFN safety plan, out-of-home plan, and family visitation plan.

On 04/17/2008, 1:30 pm: The Case Transfer/Early Services Intervention was held with the Community Based Care agency and you are the Case Manager (CM) assigned as the primary case worker on the case. You have been provided with the address of Gwen’s father, Leroy FN2, who remains incarcerated at the Duval County Jail 423 Sinclair Court. Jacksonville, FL 32209 904-5413-6744. You and your supervisor determined Reunification with the mother will be the permanency goal for the children.

On 04/17/2008, 3:50 pm: You conducted a home visit (Theresa FN1’s home) to introduce yourself to the maternal grandmother and children. You interviewed all three children and the grandmother. All three children were clean and wore non soiled clothes.

Gwen had just returned from school. She was open and talkative when you conversed with her. She said that she had not seen her mother in two days and that she is scared for her because she drinks too much. She said that she is afraid of her father (Leroy FN2) and that she was glad he is in jail for hitting Clyde. She stated, “When he gets angry, he hits us.” Gwen is in the third grade, and she said she really likes school. She stated that she “loves her grandmother very much.”

You interviewed Jean. She was smiling, but appeared a bit shy. She said she likes her school (Tot’s Daycare). When she was asked about her mother, she stated, “I miss mommy.” She ran out of the bedroom and hugged her grandmother.

You sat on the floor with Clyde, age 17 months, while he was playing with his trucks. When you asked Clyde about his mother, he said, “love mama.” Clyde exhibited physical characteristics normal for a 17-month old. He was friendly and appeared to love his sister, Gwen, who came over to check Clyde’s diaper and gave him a big hug. Gwen continuously checked on Clyde during the visit.
You checked the children’s bedrooms. All three children have their own bed. Clyde had a toddler bed with railings. All beds had clean sheets, and the house was found neat and orderly. The kitchen cabinets were stocked with food.

You interviewed Theresa FN1. The grandmother reported that her daughter (Barbara FN1) called this morning and stated that she has been staying at her friend’s (Missy Meck) house. Theresa said that Barbara was returning home today. Theresa said that Barbara has a bad alcohol problem and that she really needs help.

Theresa FN1 took Clyde, Jean, and Gwen to their pediatrician. Jacksonville Clinic; Dr. Mark Mercer, 5420 Lockville Blvd. Jacksonville, Florida 32299. The physician reported that all three children are healthy and reported no problems. All immunizations are up to date.

You provided Theresa with a daycare referral for Clyde, so she could enroll him in daycare. She stated she will enroll him in Tot’s Daycare where Jean attends. Reminded her that the shelter review/arraignment was scheduled for 4/28/08 at 1:30 pm.

On 04/17/08, 5:10 pm: You conducted a home visit and meet the mother (Barbara FN1) in her home at 1865 Riverdale Lane, Jacksonville Fl 32209. Barbara provides the following demographic data:

- Barbara FN1
- White/Female
- DOB: 01/22/1983
- SSN: 555-13-1455
- Telephone: 904 525-4596

You explained to Barbara her rights and responsibilities, and you provided her with a pamphlet. Barbara signed the required forms (HIPPA, TANF, and ICWA). You reviewed the allegation with her. You informed her that her children are under court ordered out-of-home placement with their maternal grandmother.

**Family Assessment:** You interviewed Barbara and the following is determined:

Barbara admitted to having a substance abuse problem with alcohol and wants to get help. She is currently in an unhealthy relationship with Leroy FN2 (Gwen’s father). Leroy left Barbara for another woman when Gwen was still a baby. He came back into Barbara’s life when Gwen was 6 yrs. old. Leroy can get violent at times and she has seen him hit the children. She stated that she did not return home with him after celebrating their engagement the other night because they got into a fight at the bar. She was afraid that if she went home with him, she would have been beaten. She went to her friend’s house Missy Meck and stayed there (2240 NE Sawyer St., Jacksonville, FL 32209). She stated, “I am glad Leroy is in jail. I do not ever want to see him again.”
Jean and Clyde both have different fathers. Jean’s father’s first name is James, but Barbara does not know his last name. She was only with him for a week. Barbara does not know who Clyde’s father is, as she was very intoxicated the night she got pregnant. She was raped by a man at a bar. She was afraid and did not file charges. She said she never knew his name.

Barbara’s mother, Theresa FN1, is very supportive of her and the three children and they have a good relationship most of the time. Theresa FN1, her mother, does not want Leroy in Barbara’s life or the children’s life.

Barbara has limited job skills. She worked at 7-11 as a cashier but was let go because she was often late for work (related to drinking). Barbara has a car and receives money for gas, food, and clothing for the children from her mother Theresa FN1.

Barbara admitted to getting sick a lot because she was not taking care of herself properly, i.e., not eating, feeling stressed, drinking alcohol. She feeds her children whatever is easy, box cereal, canned soup, and packaged foods. Barbara often relies on Gwen to care of Jean and Clyde. Barbara said she loves all three of her children and wants them to be happy.

Barbara was raised by her mother, Theresa FN1 and her father died when she was 2 years old in a work related car accident. Her father was a taxi cab driver. She was an only child. Barbara said she was never hit when she was growing up. She reported her mother was very good to her and that she is a very good grandmother to Gwen, Jean and Clyde.

Barbara feels stuck in life and wants help. She wants to quit drinking and get a job and provide a good life for her children.

You discussed services that are available. The following referrals were made and discussed with Barbara:

- **Jacksonville Substance Abuse Treatment Center**: Substance abuse evaluation – Follow the recommendations.
- **Jacksonville Mental Health Facility**: Psychosocial evaluation-Follow all recommendations
- **Alcoholics Anonymous**: Provided pamphlet of AA meetings and suggested that she obtain a sponsor through AA.

You informed Barbara that she has a shelter review/arraignment hearing scheduled for 04/28/08 at 1:30 pm and you provide her with a copy of the notification form.
On 04/18/2008, 9:30 am: You conducted a face-to-face visit with Leroy FN2 at the Duval County Jail. Leroy FN2 is reserved and quiet during interview. Leroy does not believe that he has a problem with alcohol. He did not want to discuss anything that took place 04/15/08. You informed him that the shelter review/arraignment hearing was scheduled for 04/28/08 at 1:30 pm. He stated, “What does it matter if I go; the kids are Barbara’s problem, not mine.”

On 04/18/09, 10:25 am: PI Denise Newman informed you that she met with Children’s Legal Services and she reviewed and signed the petition for dependency. The petition alleged Substance Exposure, Inadequate Supervision, and Environmental Hazards, against the mother, Barbara FN1. The allegations against Leroy FN2 are Physical abuse, Inadequate Supervision and Environmental Hazards.

On 04/19/2008, 1:30 pm: You attended the Red Flag staffing to review the risks in the case and the safety plan. Decision was that the current safety plan was sufficient at this time. If/when Leroy FN2 is released from jail another red flag review will be scheduled prior to his release.

On 04/24/2008, 11:00 am: You conducted a field visit to Tot’s Daycare to observe Jean and Clyde and to speak to their daycare staff. Mrs. Ranch stated that it is a pleasure to have Jean and Clyde in the daycare. There are no behavior problems or concerns. Observed Jean and Clyde interacting and playing with the other children in daycare. They were laughing and appeared happy.

On 04/24/2008, 11:50 am: You conducted a field visit to Gwen’s school; Rocky Road Elementary. You meet with Gwen’s Teacher Rachel Levi. She stated that Gwen is doing great academically and that she currently has all A’s. She reported no behavior problems with Gwen. You observed Gwen in the lunch room eating with her fellow students. Her interpersonal skills with the other students appear on target with her age. You observed her talking and laughing during lunch with her peers.

On 04/28/2008 1:30 pm: Shelter review/arraignment hearing was held. The mother consented to the allegations on the petition. Leroy’s attorney consented to the allegations for his client, Leroy FN2. Barbara FN1 has been cooperative with the agency, and she is willing to receive services. The following was addressed: Referral completed, and the mother is to submit to substance abuse evaluation and follow all recommendations; referral completed and mother is to submit to a psychosocial evaluation and follow all recommendations; visits with the children will be arranged at least twice a month, and they are to be supervised by Theresa FN1. Daycare referral was completed for Clyde, and the grandmother enrolled him in daycare this 04/18/08. The court appointed a guardian ad litem to the case for the children (Sherry Scamps). Disposition hearing is scheduled for May 9, 2008 at 9:15 am in room 220.
On 04/28/2008, 10:00 am: Completed the Family Assessment in FSFN. Submitted the family assessment to the Case Manager Supervisor.

On 05/01/2008, 2:40 pm: Received the results of Barbara FN1’s psychosocial evaluation that she completed on 4/29/08 at 9 am with Lorraine Phillips from the Jacksonville Mental Health Facility. The following were recommended for Barbara FN1:

- Submit to a substance abuse evaluation,
- 8 week parenting classes, - once a week
- 24 weeks individual therapy – twice a week

Received results of Barbara FN1’s substance abuse evaluation that she completed on 04/30/08 at 10:30 a.m. with Mark Alpern from the Substance Abuse Treatment Center. The following were recommended for Barbara FN1:

- Outpatient substance abuse treatment
- 3 times a week for 16 weeks
- Attend support group such as Alcoholic Anonymous (AA)
- Obtain a sponsor through the support group

Referrals were completed for Barbara to enroll in all recommended services.

On 05/02/2008, 1:00 pm: You attend Mediation/Case Plan Conference/Family Team Conference to discuss assessment information and recommendations from evaluations and to draft the Case Plan. Barbara FN1 was cooperative and in agreement to all tasks and services. Case plan goal is Reunification with mother, Barbara FN1. Leroy FN2 declined to attend but chose to have his attorney present. Leroy was charged and convicted of physical abuse on 17 month old Clyde. He was sentenced to 7 years in prison.

The task and services that were agreed to for Barbara FN1 are as follows:

- Submit to a substance abuse evaluation, - Substance Abuse Treatment Center
- 8 week parenting classes, - Jacksonville Youth and Family Services Facility
- 24 weeks individual therapy – twice a week - Jacksonville Mental Health Facility
- Outpatient substance abuse treatment - 3 times a week for 16 weeks
- Attend support group such as Alcoholic Anonymous (AA)
- Obtain a sponsor through the support group
- Submit to random drug testing
- Show proof to Financially provide for the children’s needs.

The tasks and services that were agreed to for Leroy FN2 (Father to Gwen) were as follows:

- Complete a psychosocial (mental health assessment) and follow all recommendations.
- Attend parenting classes and submit a copy of his certificate of completion to the Case Manager.
- Complete a substance abuse treatment evaluation and follow all recommendations.
On 05/05/2008, 3:15 pm: You conducted home visit to see the children at Theresa FN1’s (grandmother) house. You also observe a supervised visitation with the mother, Barbara FN1 and children. All three children appeared happy and healthy and were wearing clean clothes. Barbara asked to have regularly scheduled supervised visits every day with the children after school/daycare from 3:00 pm to 5:00 pm. The grandmother agreed to supervise the visitation.

On 05/06/08, 9:10 am: You spoke with GAL, Sherry Scamps. She observed interaction between the mother and the children during a supervised visit at the grandmother’s house. She explained that the grandmother is providing a safe, nurturing environment for the children and loves them dearly. She said the mom is really trying to stay sober, but she can see that it is difficult for her and that it is going to take time and support. GAL stated that she will submit her report to the courts for the disposition hearing scheduled for 05/09/08.

On 05/06/2008, 9:30 am: All parties signed the case plan and you filed it with Children’s Legal Services.

On 05/09/2008, 9:15 am: Disposition hearing is conducted. Judge accepted the case plan and the Initial Judicial Review hearing is scheduled on 08/08/08.

On 05/15/2008, 9:15 am: You conducted home visit with Barbara FN1 in her home. You reviewed her case plan tasks with her.

She began her 16 week outpatient substance abuse treatment classes 05/05/08. She attends every Monday, Wednesday and Friday. Her last scheduled class is 08/22/08. She reported that she has been to all 5 scheduled classes. She had not had a drink in 28 days. Her AA meetings were going well for her and she said she really liked her sponsor Kathleen Kingston.

She started her 8 week parenting classes 05/06/08 and attends every Tuesday. She reported going to two classes so far. We discussed some of the parenting techniques that she has learned, i.e., time out, reward system, etc… Her last parenting class is scheduled for 06/24/08.

She started her 24 week individual therapy sessions at Jacksonville mental Health facility 05/08/08. She attends every Thursday. She reported that she has attended two individual therapy sessions so far. She reported that her therapist has really helped her with understanding more about her behaviors and why she sometimes does what she does, then regrets it. Her last individual therapy session is scheduled for 10/16/08.

Barbara has seen her children every day at her mother’s house for supervised visitation. Observed the conditions of the home: clean, neat and orderly. No problems noted. All beds had clean sheets and the cupboards and the refrigerator were filled with food.
On 05/16/2008, 9:00 am: You conducted a face-to-face visit with Leroy FN2 at the Duval County Jail. He looked down at the ground and stated that “He had nothing to say.” Obtained records while at the jail and Leroy FN2 is sentenced to 7 years in jail.

On 05/16/2008, 1:30 pm: You telephoned the outpatient substance abuse treatment center 904 512-4586 to confirm Barbara FN1’s attendance at sessions. Spoke with Mark Alpern and he confirmed that Barbara has been to all 5 scheduled classes.

You telephoned Carley Thatcher 904 544-3434 to confirm that Barbara has attended two parenting classes. Confirmation was provided. Carley reported that Barbara participates and was very cooperative and attentive during class.

You telephoned The Jacksonville Mental Health facility and spoke with Lorraine Philips (therapist) 904 528-9458. Sandra confirmed that Barbara has been to two therapy sessions and is very open during their sessions.

On 05/20/2008, 3:30 pm: You conducted an unannounced home visit at Theresa FN1’s (grandmother) home. The purpose was to observe a supervised visit conducted by Theresa between Barbara FN1 and her 3 children and to assess the application of Barbara’s parenting techniques that she has learned thus far in parenting class. Barbara was observed helping Gwen with her math homework at the dining room table. Jean was drawing pictures and Clyde was sitting in his high chair eating grapes. You observed Barbara using the reward system (stickers) that she learned in parenting class. All the children appeared happy and healthy. The conditions of the home were clean and neat.

Theresa stated that Barbara has been visiting the children every day after school and will often cook dinner for them and stay for dinner. She reported that she is very proud of her daughter as she has been clean for 1 month and 5 days.

Barbara reported that she has a job interview at Wal-Mart tomorrow at 10:00 am.

On 05/21/2008, 2:45 pm: You received phone call from Barbara. She is hired at Wal-Mart; 435 Stanford Road Jacksonville, Fl. She starts work on Monday, 05/26/08. Her hours are Monday - Friday 10 am-2 pm; she will be working 20 hours a week. Her salary is $150.00 weekly.

On 05/22/2008, 9:30 am: Guardian ad litem Sherry Scamps phoned you. She was at the park with the children, Barbara and Theresa Saturday. She praised the fact that Barbara has been clean and sober for over a month. She reported that she thinks Barbara is doing very well. Sherry stated that she met Barbara’s AA sponsor Kathleen Kingston and she said that she thought Sherry was a very positive influence on Barbara. She said that Barbara was enjoying her job at Wal-Mart. She said that the children adore their grandmother and appear very happy and that their needs are being met. Sherry stated that Gwen and Jean were asking her when they were allowed to go back to live with their mother.

Sherry stated she went to Gwen’s school and spoke with her teacher. She said Gwen does very well in school. She excels in math and science. There are no behavioral problems reported.

Sherry also reported that she went to Jean and Clyde’s daycare to visit them. The daycare staff reported no behavioral problems with Jean and Clyde.
On 06/12/2008, 2:20 pm: You made face-to-face contact with Leroy FN2 (Gwen’s father) at the Duval County jail. He stated that he does not want to see Barbara and she is going to have raise Gwen because he will be in jail for 7 years. Informed him of the 08/08/08 JR hearing. He said, “I am not going to be there, I could care a less.”

On 06/14/2008, 9:20 am: You conducted unannounced Home visit with Barbara FN1 in her home. The purpose of the home visit was to assess case plan progress. Barbara’s AA sponsor Kathleen Kingston was at the house. The home environment was clean, neat, and hazard free. The cupboards and refrigerator contained a stock supply of food including bread, milk, cereal, etc… You reviewed Barbara’s case plan tasks. She currently is in substantial compliance with all of her tasks. Barbara provided a copy of her first pay stub that she received from Wal-Mart. She also provided copies of the paid receipts for the rent, water bill, and electric bill. She currently receives supplemental income from her mother. When her father died in a car accident, Barbara was two, her mother, Theresa, received a sum of money for herself and for Barbara. Theresa provides Barbara and the children with $400.00 weekly for food clothing, rent, etc... Barbara remains alcohol free and stated that she was feeling good. She said that her individual therapy sessions were really helping her to focus on herself and her children.

On 06/19/2008, 3:45 pm: Home visit conducted at Theresa FN1’s home. The purpose of the visit was to ensure the health, safety and well-being of the children. The children were doing well and the mother continues to visit regularly.

On 06/27/2008, 1:15 pm: Received a report and parenting class certificate for Barbara FN1 from Carley Thatcher regarding Barbara’s parenting classes. She completed 8 weeks of parenting class. Her last class was on 06/24/08.

On 06/27/2008, 2:00 pm: Supervisory review conducted with Lindsey Everette. Approval was granted to request from the courts, to move from supervised to unsupervised visits for the mother, Barbara FN1.

On 06/27/2008, 3:00 pm: Completed status report to the court and filed with legal, requesting permission to move from supervised to unsupervised visits with the Barbara and her children.

On 06/30/2008, 10:10 am: Received court order granting Barbara permission to have unsupervised visits.

On 07/01/2008, 3:15 pm: Home visit conducted at Theresa FN1’s home. Children are healthy, clean and safe. Barbara was provided a copy of the court order for unsupervised visits.

On 07/13/2008, 10:35 am: You spoke with Barbara’s therapist Lorraine Philips. Lorraine indicated that Barbara was making significant progress and that she recommended that it would be in the children’s best interest for overnight visits to begin to take place. She sent the report to you, putting the recommendation in writing for the courts.
On 07/14/2008, 9:35 am: You received copies of monthly reports from the providers working with Barbara: Outpatient substance abuse treatment center and the Jacksonville mental health facility. Both reports were positive and indicated that Barbara is making progress. Both reports recommend overnight visits at Barbara’s house with her children.

On 07/14/2008, 1:35 pm: Supervisory review was conducted with Case Manager Supervisor Lindsey Everette and administrator Stan Stein. Along with your recommendation, you inform that both providers, and the Guardian ad litem, were all recommending overnight visits to take place. The decision was made to motion the courts for overnight visits.

On 07/15/2008, 2:35 pm: Parental Reunification Readiness Assessment and Home study were completed on Barbara FN1’s home. Background checks were completed and were clear and home study was positive.

On 07/16/2008, 12:00 pm: Status report completed and filed with the court requesting permission to move from unsupervised to overnight visits with the mother and children. Status review hearing set for 07/17/2008 9:00 am.

On 07/17/2008, 9:00 am: Status review hearing is held. Court grants permission for mother to receive overnight visits with her children. All court orders were distributed to the parties. Judicial review hearing set for 08/08/2008.

On 07/20/2008, 3:00 pm: Home visit to Barbara FN1 home was conducted to follow up with overnight visits. Children are healthy and happy and the conditions and overnight visits will continue.

On 07/25/2008, 2:00 pm: Permanency staffing was conducted. The recommendation of Reunification with the mother, Barbara FN1, was approved by the staffing committee.

On 07/26/2008, 4:00 pm: You completed the Judicial Review Social Study/Case Plan Update (JRSS/CPU) and amended the case plan with a goal of maintain and strengthen placement for post placement supervision (PPS). You submitted documents to legal.

On 08/04/2008, 3:00 pm: You conducted home visit at Theresa FN1’s home. The purpose of the visit is to check on the health, safety, and well-being of the children. Theresa reported that Barbara will be enrolling the children in school for the upcoming school year tomorrow. She stated the children had a great summer and no problems reported. They spent the weekend again with their mother 8/1, 8/2, 8/3 (overnight visits) and all went well. Theresa said that Barbara had been taking the children to school and daycare in the mornings before she goes to work. She said she is very proud of Barbara.

You spoke with the children. Gwen said she loves her grandmother but really wants to move back home with her mother. Gwen said she is excited to start school as she is going into the fourth grade this year. Jean was laughing and said she is going to a “big girls school” this year with her sister Gwen. Jean will be starting kindergarten. Clyde was observed playing with a truck and cars on the den floor. All children appeared healthy and happy.
On 08/05/2008, 9:20 am: You spoke with GAL (Sherry Scamps). She stated she submitted her report to the court recommending reunification.

On 08/05/2008, 10:20 am: Telephoned Mark Alpern Substance Abuse Treatment Center specialist. He indicated that Barbara had attended all of her outpatient treatment classes so far and she continues to make progress. She will have her 16 weeks completed on 08/22/08. He stated he submitted his report and will be present at the hearing on 08/08/08.

On 08/05/2008, 10:55 am: Telephoned Lorraine Philips, therapist for Barbara, the mother. Barbara had attended all of her individual therapy sessions and continues to make significant improvement. She will have her 24 weeks of therapy sessions completed on 10/16/08. Lorraine is therapeutically recommending that the children be reunified with the mother. She submitted her report; she stated she will be present at court on 08/08/08.

On 08/07/2008, 3:45 pm: You conducted a home visit at Barbara FN1’s home. The purpose of the home visit was to review the case plan tasks with the mother. Barbara has substantially complied with all her tasks. Observed the home to be clean and hazard free. Gwen and Jean’s beds had fresh linens on them. Clyde’s toddler bed was observed to have fresh linens in his room as well. The cupboards were stocked with food and the refrigerator contained juices, milk, fruits, vegetables etc... Barbara indicated that she is ready for her children to be reunited with her. Barbara is enjoying her job at Wal-Mart and she provided you with a copy of her past pay stub, rent, light, and phone payment receipts. Barbara stated that her AA sponsor has really been supportive. Barbara has been clean and sober now for 4 months.

On 08/08/08, 9:00 am: Judicial review hearing was conducted. The judge granted approval of reunification with the mother and accepted the amended case plan with a goal of maintain and strengthen placement. The legal status is now Post-Placement Supervision (PPS). All court orders were distributed to the parties.
Post Placement Supervision (PPS)

PPS Notes Report

Note Information: FN1 Post Placement Supervision Scenario 08/08/08-02/09/09

The children were reunified with the mother, Barbara FN1 on 08/08/08. For the next six months the Case Manager continues to monitor the case with a goal of maintain and strengthen placement by visiting the home regularly, (07/20/08, 08/07/08, 08/20/08, 09/03/08, 09/19/08, 10/02/08, 10/20/08, 11/04/08, 11/17/08, 12/03/08, 12/19/08, 01/06/09, 01/22/09, 02/02/09), checking with providers, remaining in contact with the Guardian ad litem, and staffing the case. Barbara FN1 completes her Outpatient Substance Abuse treatment on 08/22/08. She completes her 24 weeks of individual therapy sessions on 10/16/08. She continues to remain clean and sober and in February receives her 10 month chip for being alcohol free from her AA meetings. She continues to work at Wal-Mart Monday through Friday. On 01/05/09 she began taking classes to get her A.A. degree at the community college. Barbara is in substantial compliance with all case plan tasks and her behaviors that caused the children to come into care have been eliminated.

Gwen who is in the 4th grade continues to excel in school receiving A’s on her report card. Her favorite subjects are math and science and she won 1st place in the science fair held in November. Jean is doing well in kindergarten and is able to say her ABC’s and she is starting to spell words such as cat, dog, rat, etc… Clyde is in daycare and interacts well with other children. He uses some full and complete sentences and is fully toilet trained. The three children remain in good health.

Leroy FN2 remains in the Duval County jail and has 6 years remaining on his sentence. He has chosen not partake in any of the hearings, case plan tasks or in Gwen’s life.

On 01/25/2009 at 9:30 am: Staffing occurs and you recommend to motion for case closure at the next Judicial Review hearing scheduled for 02/09/09. You have completed an updated family assessment, home study and background checks and results are positive. The staffing committee approves to motion for case closure at the next judicial review hearing.

On 01/26/09 at 3:00 pm: Termination Summary and the Judicial Review Social Study/Case Plan Update is completed and you submit it to CLS.

On 02/09/09 at 9:00 am: Judicial Review hearing is held. The court approves case closure. All parties are provided with copies of the court order terminating supervision. You close the case on FSFN.
Module 1: Ongoing Case Notes

Objectives
- Identify the process of creating case notes.
- Describe how to view and print notes.
- Demonstrate how to update Identification Records and AFCARS information.
- Create TANF for Ongoing Services

Narrative/Notes
- Completed on any case activity
- Cannot be deleted once saved; can be edited
- Any worker can enter notes on any case
- Handwritten notes maintained in paper file
TANF eligibility must be conducted every 12 months as long as the case is open for services.

Keep the completed and signed TANF form in the child’s case record for reviews, audits, program monitoring or other references.

**Module 2: Missing Child Record**

**Objectives**
- Document a Missing Child Record.
- Document a placement change when a child goes missing.

When a child goes missing, you must:
- Report the child missing to Law Enforcement, immediately if the child is 11 years or under, within 24 hours for older children.
- Notify all caregivers, parents, relatives, OIA, service providers, schools, etc.
- Complete and incident report and distribute to all appropriate parties.
- Complete the FSFN Missing Child Report following the local agency protocol.
- Notify OIA that the child is missing.
- Document all efforts to locate the child in FSFN as Narrative.
Module 3: Relative Placement

Objectives

• Add a Case Participant.
• Explain the need for a Relative Unified Home Study.
• Update an Out-of-Home and Visitation Plan.
• Document a placement change for a child.

Out-of-Home Relative Placement/Provider

Placement

• Substitute care setting where a child resides during a removal episode.

When a child is placed with an approved relative or non-relative

• The worker making the placement must add the relative or non-relative as a placement provider.

Updating an Out-of-Home Plan

When do you update an Out-of-Home Plan?

Every time the child moves to a new placement (licensed or unlicensed).
Updating a Visitation Plan

must be a collaborative effort between the PI and the CM.

assures safe and timely contacts between the separated child and his or her family, including separated siblings.

Module 4: Judicial Review Social Study/Case Plan Update

Objectives

• Create an Ongoing/Updated Family Assessment.
• Describe how to create the Judicial Review/Task Evaluation.
• Create the Judicial Review/Goal Evaluation.
• Launch, edit and print the Judicial Review template.

Ongoing/Updated Family Assessment

• Must be updated minimum every 6 months
• More frequently if family circumstances significantly change
• Six month family assessment must include:
  • Summary of casework activities for past 6 months
  • Changes in family conditions or circumstances
  • Factors affecting family strengths/protective capacities
  • Identified risks to child
  • Signs of emerging danger
  • Achieved and pending case plan goals
  • Services needed to meet case plan goals
Slide 16

**Family Interaction Tab**

- Visitations Plan Outcomes
  - 2 narrative fields
  - First - required
- Household Barriers
  - Question
  - Yes requires text field

---

Slide 17

**Recommendation Tab**

- Reasonable Efforts
  - 2 enabled text fields – not required
- Recommendations
  - 3 columns – first 2 pre-populated
  - Overall compliance - dropdown
- Recommendation to Court
  - Narrative to edit recommendations to the court – not required

---

Slide 18

**Attachments**

- Medical
- Mental Health
- Visitation Plan
- Education
- Master Trust
Module 4: Judicial Review Social Study/Case Plan Update

**Slide 19**

**Basic Placement Permanency Plan**

- Independent Living
- Recommendations
- Placement
- Permanency Plan

**Slide 20**

**JR/Goal Evaluation Basic Tab**

- Legal
- Parent/Guardian
- Child’s participation at hearing

**Slide 21**

**JR/Goal Evaluation Permanency Plan**

- Current Permanency Information
  - Last Judicial Review
  - Last Permanency Hearing
  - Last Permanency Staffing
  - Date by which next Permanency Hearing is due
  - Concurrent court approved permanency goal

- Permanency Considerations made at 12 months
Slide 22

**JR/Goal Evaluation Recommendations**

Documents family compliance and progress

- Rilya Wilson Act Compliance

---

Slide 23

**Module 5: Medical/Mental Health Documentation**

Objectives

- Explain documentation requirements for medical profile.
- Document children’s medications.
- Document mental health profile.

---

Slide 24

**Medical/Mental Health Profile**

Medical Profile  
Medications  
Mental Health Profile  
Medical History
Slide 25

Medical/Mental Health

View and update
- Child's medical history

Document
- Current Health Care Providers
- Medication information
- Basic health problems

Slide 26

Medical Profile

"Snapshot" of medical status
Information about health care providers

Primary Health Care Providers
View and update providers, emergency contact and Medicaid number

Basic Group Box
Specific health problems/allergies
Immunization status

Slide 27

Medical/Mental Health Profile

Take possession of psychotropic medication
- In original container
- Current prescription
- Advised by physician; must seek court approval

Parents/Legal Custodians
- Must be informed drug is being given

Official Record
- Reason parental authorization not obtained
- Why psychotropic medication is necessary for child’s well-being
Slide 28

**Medications Tab**

**Prescribing physician**
• Medication name

**What medication is for**
• Date prescribed and stopped

---

Slide 29

**Mental Health Profile Tab**

**Snapshot**
• Mental Health Status

**Treatment**
• View and update
• Date of CBHA

**Substance Abuse**
• Substance Abuse Information
• Referral Information

---

Slide 30

**Module 6: Parental Reunification**

**Objectives**
• Explain documentation requirements for a Parental Reunification Readiness Assessment and Home Study.
Reunification is achieved when…

Collaboration occurs with all involved persons to assess the child’s safety and the readiness of the parents and child to live together on a full time basis.

- Risk factors are reduced to a level of safety for the child.
- Parents and children have successfully spent extended periods of time together without further maltreatment.
- Parents and child indicate verbally and by their actions that they are ready for reunification.
- The family has established a strong support system.
- A positive Parental Reunification Readiness Assessment and Home Study has been completed and approved.

Module 7: Case Closure

Objectives

- Demonstrate how to end an out-of-home placement and create a living arrangement.
- Explain how to submit a case for case closure.

FSFN Case Closure

Prior to submitting a case for closure ALL pieces of work must be closed/dated with appropriate approvals completed.

- Submit the case for closure with supervisory approval.
- Allow time for the FSFN Case Closure batch to occur and for the closure status to be accepted by the system.
Module 8: Independent Living

Objectives
• Learn how to create an Independent Living Program Referral.
• Learn how to create an Independent Living Record.

Independent Living Eligibility
The Independent Living Program is for youth 13-23 years of age, who have been placed in the care, custody, and control of the Agency.

Pre independent living: 13 - 15 years of age in the custody of the agency.
Life Skills Services: 15 - 18 years of age in the custody of the agency.
Subsidized independent living services: 16 years old and up to the 18th birthday living in approved out-of-home care with daily supervision in APPLA.
Aftercare support/Road to Independence: 18 - 23 years of age in full-time education and in the minimum of 6 months prior to the 18th birthday but request services prior to reaching 23 years of age. Must be enrolled in school full-time, Florida resident and citizen.

Module 9: Interstate Compact for the Placement of Children

Objectives
• Create an ICPC Checklist from Florida to another State.
• Create an ICPC Checklist: Outgoing from Florida to another State.
• Create the ICPC 100 A and 100 B forms in FSFN.
FSFN ICPC (Interstate Compact on the Placement of Children)

Ensure all FSFN ICPC documentation is complete with signatures on all forms.

Once the 100 A and the 100 B forms are created/saved, they are located in the Forms icon on the desktop.

The Regulation 7 and the ICPC Parent/Relative/Foster Care Checklist is accessed on the Maintain Case Page.